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Perija.

Resumen. El objetivo general de este trabajo fue generar un mapa geologico
actualizado a escala 1:100.000 del area comprendida entre las coordenadas 72°00° a
73°00° latitud oeste y 10°40° a 11°00° longitud norte, a partir de las cartas Rio
Guasare (Hoja 5648) y Tule (Hoja 5748) pertenecientes a la zona occidental de la
Sierra de Perija, mediante la integracion geologica de la informacion recopilada de
datos bibliograficos y trabajos previos con los resultados del analisis de imagenes
satelitales (Landsat 7 ETM), donde quede evidenciada la correspondencia entre la
geologia superficial obtenida de los estudios previos y la informacion obtenida de las
imagenes multiespectrales.

Debido a la inseguridad que muestra la zona, originada por la accion delictiva
de grupos ilegales, asi como también, el dificil acceso del relieve abrupto de esta
Serrania, el trabajo geologico de campo que se lleve a cabo en ésta, requiere de un
método confiable que cumpla con la posibilidad de acceder a informacién a menor

costo, relativa facilidad en su acceso, y con gran seguridad. Estos beneficios lo
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suministran los Sensores Remotos y el uso de imagenes satelitales Landsat 7 ETM,
siendo estas las herramientas empleadas en la actualizaciéon de la geologia de

superficie prevista en este estudio.
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CAPITULO 1
INTRODUCCION

1.1.- OBJETIVOS Y ALCANCES

El objetivo general de este trabajo es generar un mapa geologico a escala
1:100.000 del area comprendida entre las coordenadas 72°00” a 73°00” longitud oeste
y 10°40’ a 11°00’ latitud norte, a partir de las cartas Rio Guasare (Hoja 5648) y Tule
(Hoja 5748) pertenecientes a la zona occidental de la Sierra de Perija, mediante la
integracion geologica de la informacion recopilada de datos bibliograficos y trabajos
previos con los resultados del andlisis de imagenes satelitales (Landsat 7 ETM),
donde quede evidenciada la correspondencia entre la geologia superficial obtenida de

los estudios previos y la informacion obtenida de las imagenes multiespectrales.

El alcance de este Trabajo Especial de Grado consiste en actualizar la base
cartografica geologica de la zona de estudio por medio de la informacién proveniente
de una nueva herramienta que se integrara a los estudios geologicos previos, para asi

corroborar o aportar informacion a la ya existente.

Esa nueva herramienta son las imagenes satelitales (Landsat 7 ETM), las
cuales a pesar de tener varios afios desde su apariciéon han sido poco aprovechadas

para estudios geologicos.

La integracion de imagenes satelitales a los estudios geologicos surge de la
necesidad de buscar nuevas herramientas que permitan llegar a todas aquellas

regiones consideradas problematicas por sus condiciones de accesibilidad.
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La utilizacion de las imagenes satelitales permite realizar estudios geologicos
a larga distancia con bastante exactitud, sin la necesidad de tener que movilizarse
hasta la zona de estudio (sin que esto sea entendido como el fin del gedlogo de
campo), lo que constituye una gran ventaja en zonas de dificil acceso, tal como es el

caso de la Sierra de Perija.
1.2.- UBICACION DE LA ZONA DE ESTUDIO:

La zona de estudio se encuentra ubicada en la Sierra de Perija, region
occidental de Venezuela (ver Fig. N° 1.1), y comprende un area aproximada de 2330

km® ubicada entre las coordenadas 72°00” a 73°00 longitud oeste y 10°40” a 11°00’
latitud norte (Ver Fig. N° 1.2).
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FIGURA N° 1.1 Ubicacién de la zona de estudio seglin su Situacion Relativa Nacional. Tomado y
modificado de la Hoja 5648, Rio Guasare, Venezuela.
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FIGURA N° 1.2. Ubicacién de la zona de estudio segun su Situacion Relativa Regional. Tomado y
modificado de la Hoja 5648, Rio Guasare, Venezuela.

1.3.- METODOLOGIA:
1.3.1.- Etapa de recopilacion bibliografica:

La primera etapa en la ejecucion del Trabajo Especial de Grado consistio en la
revision y recopilacion bibliografica de textos y trabajos previos, ademas de la
recopilacion de material cartografico y de las fotografias aéreas relacionadas con la
zona de estudio. Esta etapa se dio inicio desde la primera semana y se extendid hasta

la semana 15 de trabajo.
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Entre las actividades que se realizaron en esta etapa se tienen las siguientes:

»  Recopilacion de trabajos previos, tesis y publicaciones efectuadas mediante
visitas a la Biblioteca Central y a la Biblioteca Virgil Winkler de la Escuela de
Geologia, Minas y Geofisica (ambas ubicadas dentro de la Universidad Central de
Venezuela); en el Instituto de Estudios Avanzados (Universidad Simon Bolivar), y a
otras universidades del pais como la Universidad de los Andes y la Universidad de

Oriente.

»  Se recopild el material cartografico en la sede del Instituto Geografico de

Venezuela Simén Bolivar (ubicada en el Centro Simén Bolivar, Caracas).

1.3.2.- Etapa de Oficina:

Esta etapa se llevdo a cabo de manera simultinea con la recopilacion de

informacion, llegando a su final durante la semana 16.

Durante esta etapa se efectud el procesamiento, analisis e interpretacion de la
informacion que se iba obteniendo del material recopilado y de las imagenes
satelitales correspondientes al area de estudio. La informacion obtenida fue integrada
y vaciada para asi generar un mapa geoldgico a escala 1:100.000 de la zona de
estudio. Durante esté etapa se llevaron a cabo las siguientes actividades:

»  Revision y sintesis de la informacion bibliografica recopilada.

»  Revision e interpretacion del material cartografico.

»  Utilizacion del ortofotomapa.
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»  Digitalizacion, analisis ¢ interpretacion de imagenes Landsat 7 ETM y hojas Rio
Guasare (Hoja 5648) y Tule (Hoja 5748), mediante la utilizacion de los Software
“ArcGis”, “ENVI4.1”y “ERDAS IMAGE 8.6”.

»  Vectorizacion de los mapas topograficos mediante la utilizacion del Software

“ArcGis".

»  Realizacion del modelo digital de elevacion.

»  Interpretacion de los datos obtenidos durante la etapa preliminar.

»  Vaciado de la informacion obtenida en un mapa geolégico.

»  Integracion y comparacion de los datos bibliograficos y los resultados de la
interpretacion de imdgenes satelitales y la base cartografica para corroborar, apoyar o

refutar la informacion geologica existente.

> Elaboracion del mapa geologico a escala 1:100.000.
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CAPITULO 11

2 MARCO GEOLOGICO

2.1.- Generalidades

La Sierra de Perija forma parte del sistema de montafias del Caribe,
comenzando aproximadamente en el paralelo 9° N con rumbo N20E, extendiéndose
por unos 18 mil km?, su mayor altitud es el pico Tetari Kuna Yukpa con 3.750m,
(Ver Fig 2.1, Mapa de ubicacion y relieve ). La zona sur de la cordillera constituye la
divisoria de aguas entre la Cuenca del Lago de Maracaibo y el valle del rio Cesar en
Colombia; mientras que la zona norte estd compuesta por filas paralelas con rumbo
norte, hasta el nacimiento del Rio Guasare.
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FIGURA N° 2.1 Mapa de Ubicacion y relieve
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Sobre el basamento se tienen rocas metamorficas descritas por Bowen (1972),
con grado de metamorfismo correspondiente a esquistos verdes segun Hea y

Whitman (1960).

En la Sierra de Perija se distingue la Depresion o Desgarradura de Perija,
originada por la Falla de Perija, a la cota 1.800 m.s.n.m. en las cabeceras del Rio
Tucuco. Al sur de la depresion de Perija se observa la Sierra de Los Motilones, que es
la divisoria de aguas entre el Valle del Cesar al oeste y la Cuenca del Lago de
Maracaibo al este. El Tetaria es el pico mas alto de la SP con 3.750 m.s.n.m. Al norte
de la depresion de Perija se tiene la Serrania de Valledupar de Colombia, en la que se
encuentran las cabeceras de los rios venezolanos Negro, Apon y Guasare. Aqui el
pico mas elevado es el Cerro Pintado con 3.600 m.s.n.m. Los Montes de Oca se

encuentran al oeste y al norte del Rio Guasare (Mendoza, 2005).

La mayoria de las rocas de la Sierra de Perija, cuyas edades van desde el
Neoproterozoico al Neodgeno, en general muestran buena foliacion y estratificacion,
con tendencia paralela al grano estructural de la sierra, por lo cual muchos rios
transcurren a lo largo del rumbo de las capas y desvian sus cursos siguiendo fallas
ortogonales, formando estrechos y pendientes cafiones. Existe morfologia periglacial
y de solifluxion y a partir de los 2.800 m.s.n.m. rasgos glaciales como circos,
escalones rocosos, morrenas aborregadas y lomas de ballena. En direccion opuesta, es

decir hacia las planicies del Lago de Maracaibo abundan las terrazas (Mendoza 2005).

Litologicamente segin Bellizzia y Pimentel (1995) el basamento de la Sierra
de Perija estd constituido por gneises biotitico-cloriticos, anfibolitas y cuarcitas,
llamado Asociacion Perija. Sobre este basamento se encuentra una espesa secuencia
lutitas carbonaceas y siliceas, areniscas, limolitas, conglomerados y calizas
carbondceas; en la parte superior del grupo, se encuentran capas rojas con niveles

fosiliferos; esta secuencia ha sido asignada al Grupo Cachiri
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Para Bellizzia y Pimentel (1995) en la Sierra de Perija se conocen inicamente
dos eventos magmaticos: el primero del Devonico (350ma) y conocido como el
evento Antray; la segunda fase de plutonismo granitico fue acompainada de un
vulcanismo fisural de composicion basica y falsita que corresponde al Evento La

Quinta (180ma).

Fisiograficamente, segiin Ostos y Yoris (1997) la Sierra de Perija se
encuentra dentro de las Cadenas Montafiosas, en el Sistema de Montanas del Caribe,
junto con las Sierras de San Luis y Baragua, y la Cordillera de la Costa. Los rasgos
fisiograficos de esta zona se encuentran intimamente asociados a la evolucioén del
margen norte de la placa Suramericana, y su interaccion con la placa Caribe, desde el

Eoceno hasta el presente.

El clima, segin Del Castillo (1997), es del tipo tropical, muy céalido durante la
estacion de verano y muy hiimedo durante la estacion de invierno, especialmente en
las zonas de espesa vegetacion. Este clima favorece el crecimiento de una vegetacion
arbustiva en las montafas y colinas, mientras que en los valles se notan selvas

tropicales con arboles de grandes dimensiones.

2.2.- Trabajos previos

A continuacion se presenta en orden cronologico una vision general de los

estudios geologicos regionales mas importantes que se han realizado en el area de

estudio.
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Hung (1976) realiz6 un estudio petrografico y bioestratigrafico de las
Formaciones: Campo Chico, Sabaneta, Rio Negro, Colon, Guasare y Marcelina.
Obteniendo como resultado que a la Serie Perija es mas apropiado denominarla
Formacion Perija por constituir una unidad litologica bien definida. También definid

el metamorfismo de la zona como tipo abukuma. Fig 2.2 y Fig. 2.2.1

FIGURA N° 2.2 Mapa geoldgico de las cabeceras del Rio Cachiri, Sierra de Perija, distritos Mara y
Maracaibo del Estado Zulia, Modificado de Hung (1976)
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FIGURA N° 2.2.1 Cortes geologicos de la cabecera del Rio Cachiri, Sierra de Perija, distritos Mara y
Maracaibo del Estado Zulia, Modificado de Hung (1976)

Gedler (1986) realizan un estudio geoldgico general de la zona de Perija
estado Zulia, donde determinan: para el Miembro Tibt facies de “mudstone”,
“packstone’ y “wackestone”; de ambientes de cuencas restringidas y energia de baja
a moderada. El Miembro Machiques se caracteriza por calizas y lutitas negras de
ambientes marinos restringidos, de condiciones euxinicas y baja energia. El Miembro
Piché wackestone y packstone de ambientes marinos de baja energia que evolucionan
a ambientes someros de energia moderada. La Formacion Lisure consiste de areniscas
cuarzosas calcéreas, calizas y lutitas de ambientes de plataforma somera de energia
baja y alta. Formacion Maraca consiste netamente de calizas de ambiente marino

somero de moderada energia, con buena oxigenacion, luz y salinidad normal.

Adrian y Gamarra (1993) realizaron un estudio geoldgico del sector Riecito de
el Palmar en la Sierra de Perijda y determinaron que en la zona existe un
metamorfismo de bajo grado correspondiente a la facies de la Prehnita — Pumpellita.
El estado diagenético alcanzado por las rocas clasticas fue diagénesis de intermedia a
profunda. En cuanto a la geologia estructural determinaron patrones de cizallamiento
con orientacion N 40 E y N 70 E buzando sur con promedio de 48° y plegamiento
con ejes de la misma orientacion, que corresponden con el patron estructural regional.

Fig 2.3y Fig. 2.3.1

10
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olcanicas del Totumo Formacion Marcelina

FIGURA N° 2.3 Mapa geoldgico estructural de la seccion Riecito — El Palmar Escala original
1:10.000 Modificado de Adrian y Gamarra (1993)

FIGURA N° 2.3.1 Corte geologico de una seccion Riecito — El Palmar, Modificado de Adrian y
Gamarra (1993)

Testamarck (1994) realiza un estudio de los estilos estructurales del flanco
suroriental de la Sierra de Perija mediante integracion de lineas sismicas, imagenes de
radar, y mapas geologicos de superficie. Determind que en piedemonte existen zonas
triangulares que resultan de corrimientos con vergencia sureste que cortan los
sedimentos de hasta el Cretacico Inferior; estas estructuras son de edad Mio-Plioceno.
Hacia la planicie el estilo estructural predominante es de fallas transcurrentes e
inversas de angulo alto que cortan toda la secuencia sedimentaria hasta la base del

Post-Eoceno, originando flexura en los sedimentos mas jovenes.

11
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También determino que en la zona de la Sierra de Perija, actualmente, existen
fallas inversas con orientacion NNE reactivadas de fallas normales de edad Jurasico y

Cretacico Inferior.

Bellizzia y Pimentel (1995) realizan un estudio de la consolidacion de terrenos
continentales gondwanicos precambrico-paleozoicos en los Andes de Venezuela. Sus
estudios permiten dar una explicacion logica a las diferencias radicales existentes
entre los Terrenos Macizo Colorado y Mérida, con el Terreno Chibcha, comprendido
por la Sierra de Perija, Macizo Santander y Cordillera Oriental de Colombia; durante
el Precambrico-Paleozoico, cuyos nucleos igneo-metamorficos fueron estructurados

durante la tectogénesis Brsiliana, Herciniana y Caledoniana respectivamente.

Bellizzia y Pimentel (1995) consideran importante destacar que las
sedimentitas del Pensilvaniano Tardio-Pérmico, son las unicas rocas comunes a los
ordgenos del Terreno Mérida, Terreno Caparo y Terreno Chibcha, asi como las capas
rojas continentales y volcéanicas asociadas del Jurasico (periodo de adelgazamiento,
ruptura cortical y levantamiento), que dan inicio al nuevo ciclo Tectonico-

Sedimentario Andino.

Del Castillo (1997) realiz6 estudios de sedimentologia y petrologia de
areniscas y carbones en la cuenca carbonifera del Guasare lo cual sirvié para la
validacion de la Formacion Paso Diablo en la 3ra. Edicion del Léxico Estratigrafico
de Venezuela, rescatando asi el término prioritario Formacion Paso Diablo dada su

importancia geologica y economica. Fig. 2.4y 2.4.1

12
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FIGURA N° 2.4 Mapa del Neoestratotipo de la Formacion Paso Diablo en el Rio Socuy, Modificado
de Del Castillo (1997)
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FIGURA N° 2.4.1 Cortes geoldgicos de la formacion Paso Diablo en el Rio Socuy, Modificado de Del
Castillo (1997)

Lorente y Contreras (1997) realizan un estudio palinolégico en el campo de
Alturitas donde determinaron que la Formacion Peroc en su parte inferior es
Oligoceno y en la parte media y superior junto con las Formaciones Macoa y Cuibas
inferior son del Oligoceno Tardio. La parte media y superior de la Formacioén Cuibas

y la Formacion los Ranchos fueron datadas como Mioceno Temprano.

Berry (1997) mediante un estudio geoldgico detallado de los afloramientos
presentes en el area, defini6 la Formacién Campo Chico como un ciclo continental de
sedimentos fluvio-deltaicos, con algunas pequefias incursiones salobres a marinas.
Las evidencias paleobotdnicas sugieren que para el tiempo de acumulacion de estas
rocas existia una libre migracion de plantas desde y hacia la region ocupada por el
acutual estado de New York (USA), lo que sugiere la proximidad geografica o

climatica entre ambas areas durante el Devonico

Meza (1998) estudié el sistema petrolifero del Cretacico de la cuenca de
Maracaibo, y determiné que la generacion de hidrocarburos en la Formacion La Luna
y Miembro Machiques se inicia durante el Oligoceno Tardio hasta el Mioceno Medio;
las trampas estructurales y estratigraficas se forman entre el Cretdcico Tardio —
Paleoceno, Eoceno Temprano y Tardio y durante el Mioceno Tardio. La generacion
de trampas se origind durante el régimen de esfuerzos compresivos en el Mioceno
Superior, periodo donde se produce el levantamiento definitivo de los Andes

venezolanos y la Sierra de Perija.

14
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Guerra (1999) realizé un estudio estructural en la zona comprendida entre los
rios Tucuco y Ariguasd y determind que producto de diferentes eventos de
deformacion se tienen las siguientes estructuras: Inversion de una falla normal
Jurésica durante el Cretacico Tardio y el Mioceno; zona triangular de edad Mioceno
tipo Short Cut, Corrimiento que transportd el basamento en direccion este sur-este y
que pleg6 la cubierta nedgena; corrimiento ciego profundo dentro del basamento
responsable del basculamiento del frente de montana en direccion sureste desde el

Mioceno Medio hasta hoy dia.

Mediante un estudio aeromagnético Vargas (2002) determina que existe un
alto grado de continuidad anisotropica en la direccion de la estructura principal, como
lo es la Falla de Perija con rumbo Noreste — Suroeste. En cuanto al basamento
presentaria una profundizacion hacia la parte sur de la zona de estudio, mientras que

en direccidn centro norte mantiene una profundidad somera.
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CAPITULO 111
3 GEOLOGIA REGIONAL

3.1.- Precambrico

La region Andina que rodea al oeste el escudo de sur América, ha estado
estable por los ultimos 500 millones de afios y granitos calco-alcalinos derivados de
arcos magmaticos han sido adicionados como corteza juvenil durante ese tiempo

(Mendoza, 2005).

En los Andes Venezolano se localizan dos terrenos precdmbricos: 1) el
Complejo Iglesias , que cubre gran parte del centro-norte andino y 2) la Formacién
Bella Vista en el rincon SW andino, que ocupa una pequefia faja fallada y las
formaciones Los Torres, Cerro Azul, Tostds y probablemente El Aguila son también

precambricas (Mendoza, 2005).

El Complejo Iglesias cubre mas del 50% de los Andes Venezolanos, por los

estados Mérida, Trujillo, Tachira y Barinas.

La Formacion Bella Vista es una cufia fallada o cufa tectonica de direccion
NE de 75km de largo por 14km de ancho. Su zonacion tectonico-estratigrafica del
NO de Sur América la incluye conjuntamente con las formaciones Caparo y El Horno.
Bellizzia y Pimentel (1995) la incluyen en su bloque o terreno Caparo como

Asociacion litodémica Bella Vista (Mendoza, 2005).
Bellizzia y Pimentel (1.995), postularon que la Formacion Bella Vista en el

Macizo de Colorado representaba parte de un bloque autodctono ver figuras 3.3 y 3.4 o

bloque Caparo (constituido, ademés, por las formaciones Caparo y El Horno) que

16
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colindé con otro bloque aldctono, denominado Terreno Mérida (formado por las
unidades aldctonas litodémicas Sierra Nevada, Tostdos y Mucuchachi), formandose

entre ambos la sutura Caparo.

FORMACION PERIJA

La unidad aflora en la region del rio Cachiri, en el cafio Grande, en los cafos
del oeste y del sur y en el cafno Aburrido, afluente del rio Socuy, constituida
litologicamente por cuarcitas duras cortadas por diques y vetas de cuarzo blanco,
junto con micaesquitos y esquistos gneisoides intrusionados por granito(Liddle et al,
1943), posterior mente se amplia la descripcion del granito, (Sutton, 1946), Lugo
decriben la unidad compuesta por esquistos biotiticos, muscoiticos, tremoliticos,
cuarzo feldespatico y metacuarcitas cloriticas, cortadas por pequefios diques apliticos
de color rojo naranja y vetas de cuarzo lechoso, sefialando un grado de metamorfismo

correspondiente a la facies de los esquistos verdes, (Hea y Whitman, 1960).

La formacion no es lo suficientemente conocida, como para precisar sus
ambientes de formacion. Tiene el aspecto tipico de metamorfismo aureolar en una
sucesion de areniscas y lutitas, separables del Devonico mas bien por el grado que por
el tipo de alteracion. Las evidencias de campo indican la derivacion de estas rocas
metamorficas, de una sucesion sedimentaria clastica compuesta de areniscas arcosicas
gruesamente estratificadas a macizas, que gradan y estan separadas por estratos mas
delgados de lutitas; no se observan verdaderas caracteristicas sedimentarias, (CIEN,

1997).

3.2.- Paleozoico

La sedimentacion Paleozoica en Venezuela tuvo lugar entre dos periodos

orogénicos universales que ocurrieron uno a fines del Precambrico-Paleozoico
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Inferior y el otro durante el Paleozoico Superior-Tridsico, conocidas respectivamente
como Orogénesis Caledoniana (500-350 Ma) con el evento Caparoensis (400-480

Ma) y la Orogénesis Herciniana - Varistica (300-225 Ma), (Mendoza, 2005).

3.2.1.- Paleozoico Medio

El Paleozoico Medio (= Devonico + Mississippiense) no ha sido localizado en
ninguna region andina ni en El Batl ni en el subsuelo del Lago de Maracaibo y s6lo
aflora en la Sierra de Perij, en su flanco oriental donde se defini6 la Serie Rio
Cachiri y se caracterizd6 por la abundancia de fosiles indicativos de ambientes
sedimentarios plataformales poco profundos, sin ningin vestigio de metamorfismo,

(Mendoza, 2005).

GRUPO RiO CACHIRI

Tiene su localidad tipo en las cabeceras del Rio Cachiri, a unos 89 km al oeste
de Maracaibo, estado Zulia, ocupando una faja a lo largo del flanco oriental de la
Sierra de Perija hasta los distritos Mara, Maracaibo y Perija con 110 km de longitud,
llegando hasta el norte de la Republica de Colombia e incluso cerca de la Sierra de
Santa Marta. El grupo consiste mayormente de lutitas de colores negros, grises y
rojas, areniscas grises micaceas, areniscas cuarciticas y calizas de color rojo a

negruzco, (Mendoza 2005).

El Grupo Rio Cachiri se divide en las formaciones, en orden ascendente Los
Guineos, Cafio Grande, Cafio del Oeste y Campo Chico (Liddle et al. 1943).
(Bellizzia y Pimentel 1995) lo incluyen en el terreno Chibcha conjuntamente con la
Cordillera Oriental de Colombia, el Macizo de Santander y parte del Flanco Oriental
de la Cordillera Central de Colombia. El Grupo Rio Cachiri suprayace

discordantemente al Granito de Lajas (310 Ma a 370 Ma) a las rocas metamorficas de
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la Asociacion litodémica Perija e infrayace discordantemente a formaciones del
Paleozoico Tardio y Mesozoico del Grupo La Ge. Su edad en base a abundantes
fosiles va desde el Devonico Temprano hasta el Carbonifero Temprano
(Mississipiense). Estos son los tnicos sedimentos del Paleozoico Medio o Devoénico
conocidos hasta ahora en toda Venezuela., pero es abundante en la Cordillera Oriental

de Colombia. (Mendoza, 2005).

FORMACION CANO INDIO

Nombrada asi por un afluente del mismo nombre del Rio Guasare y se
componen de litologias de colores rojizos, areniscas macizas intercaladas con
limolitas que predominan hacia el tope de la formacion; y en las cabeceras del Rio
Cachiri se encuentra una asociacion similar pero intercaladas con tobas y brechas
volcanicas félsicas, también de colores rojizos, en zona de una gran complejidad
tectonica. La formacion carece de fosiles y parece no ser de ambientes marinos. Cafo
Indio es concordante y transicional en parte y discordante en parte también con la
infrayacente formacion Cafio del Noroeste, pero siempre es concordante y
transicional con la suprayacente, marina y fosilifera Formacion Rio Palmar,

(Mendoza, 2005).

FORMACION RiO PALMAR

Aflora en el rio de ese nombre y se compone predominantemente de calizas,
ooliticas cerca de la base y fosiliferas en el resto de la seccién y por sus fosiles
(fusulinidos y corales) se considera de edad Pensilvaniano inferior, asociadas con
cantidades menores de limolitas calcareas finas. En su parte media muestra dos
horizontes con ftanita posiblemente debida a cambios en las condiciones Eh-pH

sedimentarias, (Mendoza, 2005).
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3.3.- Mesozoico

El Tridsico en Perija estd evidenciado por rocas volcénicas que antecedieron a
la sedimentacion de las capas rojas de la formacion el Totumo y a todo el proceso de
expansion que estuvo relacionado a la apertura del Golfo de Mexico o Proto-Caribe,

(Ostos et al., 1997).

La ruptura o “rifting” de Pangea indujo el desarrollo de el graben de Perija.
Este “graben” fue rellenado durante el jurdsico por sedimentos continentales tipo
capas rojas, volcanicas y eventualmente clasticos y calizas de invasiones marinas,

(Ostos et al., 1997).

El Cretacico en Perijd se caracteriza por tener una sedimentacion en los
sistemas de grabenes jurasicos ver figura 3.1, como se puede evidenciar en los
clasticos arenosos de la Formacion Rio Negro. A continuacion, la subsidencia ceso y
el Grupo Cogollo (carbonético) se depositd sobre un extenso mar epicontinental
transgresivo sobre todo el occidente de Venezuela. En el cretacico superior la
formacion la luna que representa la roca madre por excelencia de la cuenca de
Maracaibo pasa verticalmente a calizas glauconiticas y lutiticas oscuras y areniscas

delgadas de las formaciones Colon y Mito Juan, (Ostos et al., 1997).
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FIGURA N° 3.1 Distrubucion de las rocas jurasicas de Venezuela que se encuentran aflorando en la

Sierra de Perija (Tomado de Ostos y Yoris, 1997)

Durante el Mesozoico se desarrollan dos provincias en Venezuela ver figura

3.3y 3.4, asaber:

1. PROVINCIA EPICONTINENTAL, autéctona, localizada al sur de las
costas actuales y comprende los Andes, Perija, la Serrania del Interior, las cuencas del

Lago de Maracaibo, de Barinas y del Oriente del Pais, (Mendoza, 2005).

2. PROVINCIA GEOSINCLINAL, aloctona, localizada al norte de las costas
actuales y por traslado tectoénico hoy ocupa la Cordillera de La Costa, Peninsulas de
Paraguand y Araya-Paria, Margarita y demas islas venezolanas en el Caribe y se

engloba como Sistema Montafioso del Caribe, (Mendoza, 2005).

La Orogénesis Herciniana-Varistica continia con caracter compresional y el
desarrollo de actividad ignea calco-alcalina con centros volcanicos en Perija y El
Baul, relacionados a la ruptura de la Pangea (200 Ma) con volcanismo basaltico y la

formacion de depodsitos sedimentarios de capas rojas continentales y lacustres,
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intercaladas con las volcanicas y la aparicion de mares incipientes muy poco

profundos, (Mendoza, 2005).

La sedimentacion del Jurasico en Perija estd representada por los sedimentos
del Grupo La Ge, que de mas antiguo a mas joven se compone de las formaciones
Tinacoa, Macoita y La Quinta. Tinacoa y Macoita se interestratifican con rocas
volcanicas y piroclasticas de la Ge y las rocas de la Formacion La Quinta con rocas

volcanicas de El Totumo, (Mendoza, 2005).

3.3.1.- Jurasico

FORMACION LA QUINTA

La Formacion La Quinta aflora extensamente en la parte suroeste de los
Andes de Mérida (estados Tachira, Mérida y Barinas), en areas aisladas en la parte

noreste (estado Trujillo), y en el flanco este de la sierra de Perija, (CIEN, 1997).

Litoldégicamente la Formacion La Quinta en la sierra de Perija, ver figura 3.2,
se describio en la quebrada La Ge, donde se divide en tres intervalos: uno inferior
(700-800 m, aproximadamente la mitad de la secuencia total), consistente de arcosa
marrdn a roja oscura, fina a mediana, con pocas intercalaciones volcénicas, y la cual
contiene fragmentos vegetales y de carbon; una zona de transicion (aproxidamente
100 m), la cual se compone de capas de basalto-andesita (a mas de 20 m de espesor),
conglomerado tobaceo, y arcosa verde, mediana a gruesa, con intercalaciones de
arcosa marrdn a rojo oscuro, y lutita roja a negra (rara vez verde) fosiliferas; y un
intervalo superior (700-800 m), con rocas de grano mas grueso (localmente
conglomerado de cantos), consistente principalmente de arcosa roja oscura a marrén

oscura, de grano grueso, y capas finas de ceniza félsica roja a rosada. El contenido de
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rocas volcanicas decrece de norte (donde predominan en la formacion) a sur (hasta

menos de la tercera parte del total), (Maze, 1984).

La Formacion La Quinta representa capas rojas en facies de conos
piedmontinos y de sedimentos aluviales. En la zona de El Totumo, asi como en
Alturitas e Isla de Toas, la Formacion La Quinta estd parcial a totalmente
reemplazada por rocas volcénicas y piroclasticas basicas a intermedias. La Formacion
La Quinta se divide en dos miembros: el Miembro Inferior compuesto de areniscas
rojas de grano fino intercaladas y reemplazadas por las rocas volcénicas de El
Totumo y el Miembro Superior, representado por el Conglomerado de Seco, sin la
presencia de las rocas volcanicas de El Totumo. La Formacion La Quinta infrayace

unas veces concordantemente y otras discordantemente a la Formacién Rio Negro,
(Mendoza, 2005).
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Figura N° 3.2 Cuadro de unidades litoestratigraficas del Triasico — Jurasico de Vernezuela y columnas
litoestratigraficas de las formaciones palmarito y La Quinta en la quebrada Bellaca y de la Formacion

Macoita aflorante en el Cafio Cuna de la Sierra de Perija, (Martinez, 2005).
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FIGURA N° 3.3 Distibucion de las unidades aldctonas, para-autoctonas y autoctonas, en el norte de

Venezuela, (Mendoza, 2005)
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3.3.2 Cretacico
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FIGURA N° 3.4 Distribucion de las facies sedimentarias dominante durante el Neocomiense-albiense
(Cretacico Temprano) al norte de Guayana. Se indican unidades tipicas de dicha asociacion de facies,

(Ostos y Yoris, 1997)

FORMACION RIO NEGRO

La unidad aflora en la mayor parte del occidente de Venezuela, en los estados
Zulia, Téachira, Mérida. Exhibe buen desarrollo en secciones de la depresion Tachira.
Esta ausente en el subsuelo de la cuenca Barinas y en los rios del flanco surandino

entre las cercanias de Santa Barbara de Barinas y el rio Calderas, (Kiser, 1997).

La descripcion litologica es la siguiente: Areniscas blancas, generalmente de

grano grueso, conglomerados heterogéneos; arcillas y lutitas variables, tipicamente en
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tonos brillantes de amarillo, rojo y morado. De acuerdo con su fuente sedimentaria,
las areniscas varian desde muy cuarzosas (surco de Uribante), a muy feldespaticas
(surco de Machiques). Se describe posteriormente una columna estratigrafica,
representantiva de esta unidad en la region central de la subcuenca del Uribante,
aflorante en la region de La Fundacion, estado Tachira. Esta secuencia se inicia, con
capas de arenisca de grano fino a grueso y conglomerados, en capas de hasta 1 metro
de espesor, de color gris claro, con manchas rojizas debido a lixiviacion de los
sedimentos rojos de la formacion La Quinta, infrayacente. Estos estratos estan
intercalados, con niveles de lutitas y limolitas negras que se hacen dominantes en los
200 metros basales. Se trata de limolitas y lutitas calcareas, en partes carbonosas,
muy fosiliferas, intercaladas con capas de caliza y yeso, entre 1 y 2 metros de espesor.
Suprayacente a esta secuencia, se presenta una alternancia de capas potentes de
conglomerados de grano grueso y de lutitas, distribuidas en estratos que varian entre
1 y 5 metros. Las capas conglomeraticas, estan formadas por clastos, en su mayoria
de cuarzo, redondeados a subangulares; presentan escogimiento pobre coloracion
blanca a gris pardo. La textura es variable al igual que su composicion mineralogica.
Es frecuente la estratificacion cruzada asintotica, hacia la base y cortada hacia el tope,
dentro de un rango que varia entre 1 centimetro y més de 1 metro. Los rellenos de
canales son frecuentes en todo este intervalo, y alcanzan dimensiones variables, desde
pocos centimetros hasta mas de 3 metros de ancho. Las capas luticeas y limoliticas
intercaladas en la secuencia, son de color gris oscuro a negro, finamente laminadas y
con restos vegetales; localmente los niveles limosos arendceos, presentan
laminaciones y estratificacion cruzada, que recuerdan las macroestructuras de los

estratos conglomeraticos, (Van Andel, 1958)

En la parte media de la formacion, se presentan horizontes de coloracion
rojiza que recuerdan a la Formacion La Quinta y es posible que ello se deba a erosion
y resedimentacién de estratos de esa formacion. Los términos superiores de esta
columna, estdn formados por capas de areniscas conglomeraticas; con estratos

alternantes de poco espesor de lutitas y limolitas oscuras. El contacto superior, esta
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definido por la aparicion de los primeros horizontes calcareos de la Formacion Apon,

(CIEN, 1997).

Los ambientes de sedimentacion de la Formacion Rio Negro son variables: La
secuencia calcarea-lutdcea y yesifera, se depositd en un ambiente de lagunas
costaneras, llanuras de marea o albuferas, salinidad anormal, presumiblemente
hipersalinas con poca circulacion y baja oxigenacion; la secuencia de areniscas con
estratificacion cruzada, se depositd en un ambiente deltdico a marino costanero; y la
secuencia de conglomerados y areniscas coglomeraticas, en un ambiente deltéico,
donde cada nivel de conglomerados indica una pequenia pulsacion del ciclo fluvial,
con disminucidn de la energia mecanica, de la base al tope de la secuencia, (CIEN,

1997).

FORMACION APON

MIEMBRO TIBU

Se extiende desde su localidad tipo en la Concesion Barco de Colombia,
desde las areas de Tarra y Rio de Oro, hasta los campos de La Paz y Mara y
plataforma de Maracaibo, a lo largo de los Andes y continta hasta los estados Trujillo
y Lara, con la posible excepcion de una region sobre el Arco de Mérida, (CIEN,

1997).

No existe una distribucion regular dentro de la secuencia, la cual se presenta
bien estratificada. La parte inferior estd formada por calizas arenosas, areniscas
calcareas y lutitas y no es rara la presencia de glauconita, mientras que la parte

superior es practicamente calcarea. (CIEN, 1997).

Consiste en varios tipos de calizas: cristalina de color gris claro a medio,

maciza, bioclasticas (coquinoide) con abundantes macrofosiles, criptocristalina,
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laminar con olor fétido y dolomita. Las capas individuales varian desde 50 cm a
varios metros y estan interestratificadas con margas de colores mas claros. Existen
intercalaciones de caliza nodular en los Andes y el piedemonte de Perija. El Miembro
Tibl mantiene una litologia bastante uniforme a través de Venezuela occidental,

(CIEN, 1997).

La fauna indica un ambiente neritico, tranquilo y bien aireado, (CIEN, 1997).

MIEMBRO MACHIQUES

Estd circunscrita al surco de Machiques hasta el campo Alpuf al Norte,
consiste en una sucesion de calizas laminadas, gris oscuro a negro, bituminosas, con
olor a petrdleo, piriticas y con pelotillas fecales, calizas margosas y lutitas que
contienen concreciones calcareas discoidales, con un diametro maximo de 2 m, a
menudo ricas en macrofosiles. Hay también intercalaciones de calizas no bituminosas.
En el campo, la litologia del Miembro Machiques es muy similar a la de la Formacion
La Luna, la diferencia consiste en su contenido fosilifero: el primero tiene una fauna
pelagica pobre, mientras que en La Luna, los foraminiferos pelagicos estan mejor
desarrollados. En las regiones de rio Apon y rio Negro, la formacion esta dividida por

un cuerpo de caliza conchifera de 20-50 m de espesor, (CIEN, 1997).

Es considerada como el producto de dos condiciones intercambiables: facies
de lutita negra de condicion restringida, y una facies de caliza bien aireada con

profundidades epineriticas a infraneriticas, (Rod y Maync, 1954).

MIEMBRO PICHE

Se encuentra desde la subcuenca de Machiques, al campo La Paz y plataforma

de Maracaibo. No se reconoce hacia los Andes, (CIEN, 1997).

Consiste en varios tipos de calizas entre las que se encuentran: fosiliferas del

tipo coquina, criptocristalina, de estratificacion media a delgada con planos de
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estratificacion ondulados con intercalaciones de color gris oscuro a negro, nodulares
con estratificacion delgada, nodulares margosas y margas de color gris claro azulado.

Por litologia, solamente resulta dificil de diferenciar del Miembro Tib1, (CIEN, 1997).

La primera microfacies de Apon formada en la parte inferior de la accion del

oleaje, se encuentra en forma tipica en las Calizas de Piché, (Ford y Houbolt, 1963).

FORMACION LISURE

El cambio con la Formacion Aguardiente es gradual, y su limite se coloca
donde la proporcion de calizas es menor al 40%, lo cual sucede hacia el extremo sur
del lago y los andes, y al sureste en la Concesion Barco, (Gonzalez de Juana et al.

1980).

Consiste en areniscas glauconiticas de grano medio a fino, de color gris
azulado a gris verdoso, calizas arenosas glaucointicas laminadas, areniscas micaceas
que alternan con lutitas arenoso-arcillosas de color gris azulado, calizas glauconiticas

y algunas calizas lutiticas, (CIEN, 1997).

Esta representa facies de aguas marinas de plataforma costera con
profundidades variables. En las cuales se considera que la abundancia de material
clastico, indica el extremo septentrional de un influjo de arena, suministrado por el
Escudo de Guayana. Se pudo interpretar un ambiente marino somero a intermarea,
con tasas bajas de sedimentacion carbonatica, con algin influjo de aguas dulces,

sedimentos lagunares y de alta energia hacia el tope, (Leon, 1975).
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FORMACION MARACA

Se reconoce por la sierra de Perija hasta el rio de Oro, pero no se ha reportado
en la Concesion Barco al suroeste. Hacia Los Andes es reconocida en Tachira-Tarra,
y en Pregonero, en el camino La Grita-Seboruco y al norte de los estados Trujillo y

Lara, (CIEN, 1997).

Litologicamente consiste en pocas areniscas glauconiticas y calcareas hacia la
base, en transicion con la Formacioén Lisure infrayacente, pero el caracter mas
distintivo lo constituyen las calizas bioclasticas coquinoides macizas, formadas
predominantemente por Ostreas y Trigonia, con algunas, intercalaciones de capas
delgadas de margas y lutitas de color gris y ocre claros. También puede presentar
ooides y granos cubiertos, y algunos granos angulares de cuarzo, fosfato y pirita. Las
calizas se asemejan a la de los miembros Piché, y Tibu de la Formacion Apon, (CIEN,

1997).

Se considera que la formacion representa una facies de aguas llanas, cercana a
la costa, donde se interpretan ambientes lagunales a intramarea en la base, que pasa a

marino llano hacia el tope, (CIEN, 1997)

FORMACION LA LUNA

La unidad se presenta en toda la extension de la cuenca del lago de Maracaibo,
estado Zulia, como también en los estados Falcon, Lara, Trujillo, Mérida, Tachira,

Barinas y la peninsula de La Goajira, Colombia, (CIEN, 1997).

La Formacion La Luna consiste tipicamente de calizas y lutitas calcareas
fétidas, con abundante materia organica laminada y finamente dispersa, delgadamente
estratificadas y laminadas, densas, de color gris oscuro a negro; la ftanita negra es
frecuente en forma de vetas, nédulos y capas delgadas; las concreciones elipsoidales a

discoidales de 10 a 80 cms de diametro, son caracteristicas tipicas de la formacion,
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que permiten reconocerla en cualquier afloramiento. Muchas de las concreciones
tienen amonites y otros macrofosiles en su interior. Las capas de caliza varian en
espesor de 1 - 2 cms hasta unos 50 cms, con estratificacion uniforme y mondtona.

Fracturas frescas de las calizas tienen olor caracteristico y fuerte a bitumen.

En la region de Trujillo-Lara, la unidad ha sido subdividida en tres miembros
denominados La Aguada, Chejendé¢ y Timbetes, en orden ascendente, (O. Renz,
1959). En la regién de Téchira-Barinas, Renz nombr6 la Lutita de La Morita,
considerada por autores posteriores como miembro local de las formaciones La Luna
y Navay. Otra unidad que algunos consideran como miembro de la Formacion La

Luna es el Chert (Ftanita) de Tachira, (CIEN, 1997).

La formacion La Luna aparentemente se depositd en un ambiente euxinico de
aguas cuya profundidad ha sido objeto de mucha controversia. Se indican
profundidades que van de 100 m en el Turoniense hasta aproximadamente 800 m en
el Campaniense, y mencionan condiciones euxinicas del Turoniense hasta el
Santoniense, (Boesi et al. 1988). Tambien se mencionan ambientes disaerobicos para

el Miembro Tres Esquinas del Campaniense, (Romero y Galea, 1995).

FORMACION COLON y MITO JUAN

La Formacion Mito Juan se extiende superficialmente tanto como la
Formacion Colon, ya que en muchos lugares se diferencia de ella muy dificilmente y
en otras partes no se ha intentado diferenciarlas. Se encuentra en la parte occidental y

meridional de la cuenca del lago de Maracaibo, (CIEN, 1997).

La litologia de la Formacion Mito Juan se caracteriza por arcillas grises, gris
verdosas y negras, localmente arenosas, en las cuales el contenido de limo y arena
aumenta en sentido ascendente y en cuya parte superior se encuentran a veces capas
delgadas de calizas y areniscas. En la parte inferior de la formacion hay algunas

arcillas laminares grises que son indistinguibles litologicamente de las arcillas de
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Coldn. Son particularmente comunes concreciones discoidales de arcilla ferruginosa
formando capas delgadas. Las arenas se clasifican en el grupo de las grauvacas y
subgrauvacas y en el grupo de las areniscas cuarzosas en el flanco noreste de Mérida,
(Van Andel, 1958). En la parte superior se presenta localmente un intervalo de calizas

conocido como Miembro Rio de Oro, (CIEN, 1997).

La microfauna indica ambientes de aguas salobres, poco profundas,

evidenciando en esta forma el relleno de la Cuenca, (Sutton, 1946).

3.4 Terciario

A comienzos del Paleoceno Venezuela occidental sufri6 finalmente el efecto
de la colision entre la placa de Nazca y el occidente colombiano. Los frentes de
deformacion del evento de la colision de estas placas generaron sucesivos
depocentros de edades cada vez mas jovenes hacia el este de lo que hoy en dia es la
Sierra de Perija. La sedimentacion en el Eoceno estuvo controlada por los frentes de
deformacion del Caribe, acumulandose sedimentos finos de talud continental, (Ostos

etal., 1997).

Durante el Oligoceno la acumulaciéon de sedimentos en la cuenca de
Maracaibo fue preservada mayormente hacia sus flancos: en Perija los clasticos
arenosos de las Formaciones Carbonera y Ceibote (Grupo el Fausto), (Ostos et al.,

1997).

El Nedgeno en Venezuela se caracteriza por el levantamiento de diversas
cadenas montafiosas. En Perija, el Grupo el Fausto es la unidad equivalente molasica
relacionada en este caso con las montafias de los frentes de deformacion en el limite

occidental de la Cuenca de Maracaibo, (Ostos et al., 1997).
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3.4.1.- Paleoceno

FORMACION GUASARE

Los afloramientos de la Formacién Guasare se presentan a lo largo de una faja
de 50 a 60 km de ancho, que se extiende a lo largo de los contrafuertes de la sierra de

Perija, desde el rio Guasare, hasta el area sur del distrito Perija, (CIEN, 1997).

En los afloramientos de los rios Guasare, Socuy y Cachiri, la formacion
consiste en calizas pardo grisaceo a gris amarillento o gris, generalmente
glauconiticas. Algunas capas son ricas en restos de Ostrea y Venezulia. Intercaladas
con las calizas, se presentan lutitas y limolitas grises a parduscas y areniscas grises,

calcéreas y glauconiticas, (CIEN, 1997).

La Formacion Guasare representa la sedimentacion de plataforma,
desarrollada en la porcion central de la cuenca de Maracaibo durante el Paleoceno. Su
litologia y contenido fosilifero, corresponden a un ambiente marino neritico, el cual
estuvo sujeto a influencias de tipo deltaico, especialmente hacia el suroeste, donde se
observa la interdigitacion de la tipica litologia de Guasare con los sedimentos del

Grupo Orocué, (CIEN, 1997).

FORMACION MARCELINA

Los afloramientos de la Formacion Marcelina abarcan una faja de unos 54 km
de largo, por no més de 4 km de ancho, que va desde unos 3 km al norte del rio
Guasare, hasta la confluencia del cafio Colorado con el rio Palma, al sur, (Motiscka,
op. cit.). En el subsuelo, ha sido identificada en los campos de Alturitas, (Key, op. Cit.
y Alpuf Quijada y Caldera op. cit.), en el distrito Perija. Se sefiala su extension en la

vertiente occidental de la sierra de Montes de Oca, en ¢l valle del rio Rancheria,
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Colombia. La formacién desaparece hacia el este, en el lago de Maracaibo, por

erosion, (Miller y San Juan, 1963).

La litologia de la formacion es una intercalacion de areniscas, lutitas, lutitas
arenosas y capas de carbon. En la base de la unidad, las areniscas son macizas,
gruesas, de color gris claro y localmente calcareas. Més arriba se hacen delgadas,
estan intercaladas con lutitas color gris y presentan planos de estratificacion con mica
y carbon. Las lutitas son de color gris oscuro a negro, con fractura concoidal o de
lapices. Tanto en las areniscas como en las lutitas, se encuentran nédulos de arenisca
y caliza arenosa de color gris azulado, de forma alargada y midiendo de 1.2 a 2.4 m
de largo por 0.6 a 1.2 m de didmetro. El carbon es de tipo subbituminoso a
bituminoso, y se presenta principalmente hacia la base de la formacion, en capas de 2
hasta 10 m de espesor, (Sutton, op. Cit.). En el rio Socuy se observan capas de caliza y
areniscas calcareas con restos de moluscos. Las calizas son generalmente delgadas,
aunque en la parte inferior de la seccidn, senalan una capa de 3 m, (Miller y San Juan,

1963).

En la Formacion Marcelina se observa un conjunto de rocas alteradas por el
calor de la oxidacién (combustion) de mantos de carbodn. Interpretadas erroneamente
como de origen igneo, fueron estudiadas en forma detallada por, (Moticska, 1977),
quien determind tres tipos principales: porcelanitas producto de limolitas carbonéaceas
y en parte de areniscas finas, calizas y conglomerados; brechas soldadas y flujos de
brechas formados por fragmentos liticos embebidos en roca fundida, y lavas (para-
lavas) formadas por la fusion completa del material rocoso. Todas estas variedades

presentan diversas tonalidades de rojo, marrén y ocre, (CIEN, 1997).

La Formacioén Marcelina representa un ambiente sedimentario de tipo paludal,
originado por el avance deltdico del Paleoceno, sobre los ambientes de plataforma de

la Formacién Guasare, (CIEN, 1997).
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3.4.2 Eoceno
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FIGURA N° 3.5 Generacion de cuencas extensionales (Tomado de Ostos y Yoris, 1997)

FORMACION MIRADOR

La Formacioén Mirador aflora extensamente a lo largo de los flancos de la
sierra de Perija, Zulia suroccidental, en el estado Tachira y partes adyacentes de

Colombia y en el subsuelo en los campos de Tarra, (CIEN, 1997).

Litologicamente la seccidn tipo se caracteriza por areniscas blancas de grano
fino a medio con capas delgadas de granulos o guijarros de cuarzo; toda la seccion
presenta material carbondceo, observandose algunas intercalaciones de lutitas en su
tercio superior y capas delgadas de carbon interestratificadas con las mismas. Se

dividié en tres unidades informales descritas a continuacion:
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El intervalo inferior estd constituido por areniscas macizas de grano grueso
con estratificacion cruzada en escala de metros, intercaladas con arcillas limosas y
arenosas. Hacia el sur se observan algunos niveles conglomeraticos, en el subsuelo de
Alturitas, las areniscas son de grano fino y laminadas. En el subsuelo se encuentra un
intervalo lutitico de 20 a 30 m de espesor, que se caracteriza por arcillitas y lutitas
gris oliva claro, localmente carbonaceas y con una o dos capas lenticulares de carbon.
Este intervalo constituye un marcador notorio en los registros eléctricos de pozos
relativamente cercanos, y no parece tener continuidad regional, como sucede al sur de
Tachira donde esté ausente. El intervalo superior, muestra areniscas cuarzosas limpias
de grano grueso a conglomeraticas; las areniscas son lenticulares con acanaladuras y

frecuentemente macizas (Gonzalez de Juana et. al., 1980).

La Formacion Mirador en el sector de San Pedro del Rio-Michelena, estado
Tachira, se interpreta como un ambiente de estuario dominado por olas, de poca
profundidad y gran extension lateral, y considera que el modelo fluvial de rios
entralazado no debe aplicarse a esta zona. La presencia de un estuario indica la
existencia de una importante masa de agua en la region, considerada marina entre

otras cosas a la existencia de flora costera, (CIEN, 1997).
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3.4.3 Oligoceno
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FIGURA N° 3.6 Marco geoldgico regional para la sedimentacion en Venezuela Occidental (Cuencas
de Maracaibo, Falcon, Barinas-Apure y Oriental-Subcuenca de Guarico) durante el Oligoceno. Los
mayores depocentros se concentranron hacia los estados Tachira (Formacion Leon), Falcon

(Formaciones Pecaya y Agua Salada) y Guarico (Formacion Roblecito) (Ostos y Yoris, 1997)
FORMACION PEROC

La Formacion Peroc se extiende desde el area del pozo Peroc-1 al norte, hasta
el campo Alturitas, al sur. Por el este, extiende hasta el campo Alpuf donde se

confunde lateralmente con la Formacion Icotea, (CIEN, 1997).

En la localidad tipo, la Formacion Peroc consiste en arcilitas y limolitas
moteadas o multicolores, variando los colores del gris aceituna a gris parduzco,
marron claro, marréon amarillento oscuro y tonalidades de rojo y purpura. Se
encuentran ademdas, areniscas delgadas, anhidrita, lignito, pelotillas de siderita y

abundante pirita. (Miller y Sanjuan, 1963).
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La Formacion Peroc se subdividio en tres miembros informales, Inferior,

Medio y Superior, cuyas caracteristicas litologicas son:

Miembro Inferior. Comienza con lodolitas o limolitas verdosas, seguidas
hacia arriba por una intercalacion de lutitas, limolitas, arcilitas y areniscas y lignitos

con cantidades menores de calizas pardo-azuladas y calizas arcillosas, (Young, 1958).

Miembro Medio estd formado principalmente por lutitas gris oscuro o gris
verdoso, con menor proporcion de arcilitas pardo claro, limolitas gris claro y lignito.
Se describe en Alturitas, como una lutita gris verdoso oscuro, mas o menos dura y a
veces laminada, facilmente identificable en perfiles eléctricos y muestras de canal,

(Young, 1958).

Miembro Superior se describe, como una arcilita color pardo claro, con
intercalaciones menores moteadas en rojo, gris, purpura, rosado y blanco. Hacia el sur,
predominan lutitas y arcilitas verdes, con intercalaciones de arcilitas marrén claro,
purpura y gris. En Alturitas, se describen lutitas y arcilitas gris, verdoso, arcilitas
moteadas en gris y marron rojizo y areniscas de grano fino y colores claros. (Young,

1958).

La Formacién Peroc representa condiciones de sedimentacion en aguas
salobres a lagunares, con posibles incrementos ocasionales de salinidad, (CIEN,

1997).

3.4.4 Mioceno

FORMACION CUIBA

La Formacion Cuiba se extiende desde el Alto de El Totumo, al noroeste de

Villa del Rosario, al norte, hasta el campo Alturitas, al sur. Por el este, llega hasta el
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campo Alpuf 'y a las inmediaciones del campo Boscan, donde grada a la Formacion

Lagunillas, CIEN 1997)

Se compone de arcilitas verde aceituna, moteadas en verde aceituna claro y
gris, rojo oscuro, rojo purpura, grisiceo y marrén. Las arcilitas son limosas y
arenosas, y estan intercaladas con cantidades menores de areniscas color verde
aceituna grisaceo claro, de grano fino a medio. Se encuentran algunas capas de lignito
y pelotillas de siderita, (Miller, op. cit.). Los colores de la formacion cambian hacia el
sur, donde predominan tonalidades de gris rojizo, (Young, op. cit.).. En el campo
Alturitas, se describen arcilitas gris claro, moteadas en rojo, purpura, marrén y verde,
con areniscas color gris, de grano fino, lignito y esferulitas de siderita, (Key, op. cit.).
En el campo Alpuf, se reconocen arcilitas abigarradas en tonos gris claro, gris
verdoso, amarillo naranja, marrén, plrpura y rojizo. Las areniscas son de grano fino a
medio, subredondeado a subangular, moderadamente consolidadas. Hacia el oeste del

campo, sefialan fragmentos de chert y pirita. (Quijada y Caldera, 1985).

La Formacion Cuiba representa sedimentacién en aguas salobres en planos

costeros, (CIEN 1997).

FOMACION MACOA

La formacion se extiende desde el pozo Peroc-1, 14 km al noroeste de Villa
del Rosario, hasta la vecindad del anticlinal de Macoa al sur, y el pozo Zulia 36E-1;

al este, la formacion llega hasta el campo Alpuf, (Miller y Sanjuan, 1963).

En la seccion tipo, la Formacion Macoa estd compuesta por arcilitas y
limolitas, con cantidades variables y subordinadas de areniscas. Las arcilitas y
limolitas presentan colores de gris claro a gris aceitunado. Las areniscas son de grano

fino a medio, con colores gris, aceitunado o marroén. Se encuentra ademads lignito en
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vetas o laminas delgadas, agregados de pirita y granulos de giauconita, (Miller op.
cit.). Se mencionan también lutitas gris oscuro a marrén, como caracter distintivo
respecto a la Formacion Cuiba suprayacente, (Young, op. Cit.). El color de las lutitas
cambia al verde hacia el sur. En el campo Alturitas, se describen arcilitas de color gris
claro a verdoso, moteadas de rojo, lutitas gris a gris oscuro, laminadas y carbonaceas
y areniscas de colores claros y grano fino a medio, (Key, op. cit.). La formacion en el
campo Alpuf, se describe como arcilitas gris a gris verdoso a veces moteadas en
amarillo y marron, especialmente al este del campo, lutitas gris, gris oscuro a gris
verdoso, limoliticas, carbondaceas y piriticas y areniscas blancas a gris claro, de grano
fino a medio, subredondeado, con escogimiento moderado y cemento siliceo, o a
veces calcareo. Las areniscas presentan glauconita, y al oeste del campo, fragmentos

de chert. (Quijada y Caldera, 1985).

La Formacion Macoa representa condiciones de sedimentacion mas marina
que las de las formaciones Cuiba suprayacente y Peroc infrayacente, y que
corresponderian al ciclo transgresivo representado en todo el lago de Maracaibo, por

la Formacion La Rosa, (CIEN, 1997).

FORMACION LOS RANCHOS

La Formacion Los Ranchos aflora en la zona piemontina de la sierra de Perija,
en el distrito Perijd. En el distrito Mara, se mencionan afloramientos al este de la falla
de Los Ocho, entre los rios Cachiri y Guasare y a lo largo del eje del sinclinal de
Manuelote. En el subsuelo, la formacion se extiende hacia el este, hasta pasar a la
Formacion Lagunillas cerca de la costa occidental del lago de Maracaibo, (CIEN,

1997).

El area tipo Los Ranchos estd compuesta en un 50 6 60%, por areniscas bien

estratificadas, micdceas y ferruginosas con algunas capas delgadas de areniscas
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conglomeraticas y conglomerados, el resto de la litologia se compone de lutitas
arcillosas grises, y arcilitas. Al sur del rio Apon, en la parte central de Perija, el
contenido de lutitas grises alcanza a mdas de las tres cuartas partes de los
afloramientos, combinadas con areniscas ferruginosas delgadas, con estratificacion
cruzada (Miller y Sanjuan, 1963).

Los sedimentos de la Formacion Los Ranchos representan un ambiente de lagunas
costeras de agua dulce o salobre, con alguna influencia de sedimentacion subaérea

(CIEN, 1997).

3.4.5 Pleistoceno

FORMACION EL MILAGRO

La Formacion El Milagro cubre el Arco de Maracaibo y se extiende hasta la
parte noreste del lago de Maracaibo. Se observa también en el subsuelo del lago, y en
el distrito Bolivar del estado Zulia, (CIEN, 1997).

Sobre el Arco de Maracaibo, la formacion consiste de arenas friables, finas a
gruesas, muy micaceas, de color crema a pardo-rojizo, limos micaceos de color gris
claro, interestratificados con arcillas arenosas, rojas y pardo-amarillentas y lentes
lateriticos bien cementados. Hay dos capas de arcillas arenosas y limosas, con
abundantes fragmentos y troncos de madera silicificada. Estas capas cubren
horizontes caracterizados por abundantes nodulos de hierro y formacion lateritica,
que fueron interpretados como paleosuelos, (Graf, 1969). El paleosuelo superior
separa la gruesa unidad inferior de la seccion arenosa, caracteristica de la Formacion
El Milagro. El paleosuelo inferior esta desarrollado sobre el centro del arco, y separa
la Formacién El Milagro de una unidad verdosa, posiblemente equivalente a la

Formacién Onia (Graf, 1969).
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Estos sedimentos son de aguas dulces y llanas, depositados a una distancia
considerable del area fuente (Sutton, 1946). Consideran que el ambiente de
sedimentacion de la Formacion El Milagro es fluvio-deltdico y lacustino marginal
(Kerez y San Juan, 1964). Los sedimentos de la formacion son de caracter fluvial y
paludal, que se depositaron sobre un amplio plano costanero y de poco relieve, y
estuvieron expuestos a la meteorizacion y anegamiento por lo menos tres veces
durante el Cuaternario Graf (1969). Estas condiciones facilitaron la accion edlica y
algunas capas de la formacion, pueden representar dunas (Gonzalez de Juana, et al.,

1980).
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FIGURA N° 3.7 Columna diagramatica ilustrativa de una region de la Sierra de Perija, (CIEN, 1999)
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FIGURA N° 3.8 Corte diagramatico ilustrativo de una region de la Sierra de Perija.
KI Cretacico inferior, KS Cretacico superior, Jr Jurasico, Pc Precambrico, Pz Paleozoico
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CAPITULO IV
4 BASES TEORICAS

4.1.- Percepcion remota

La Percepcion Remota (Remote Sensing) o Teledeteccion puede definirse
como la ciencia y arte de obtener informacion de un objeto analizando los datos
adquiridos mediante algun dispositivo que no esta en contacto fisico con dicho objeto

(Lillesand et al, 2000).

Es la obtencion de informacion de imdgenes lejanas del ambiente, sin tener
contacto directo con ¢él, mediante la transferencia de energia efectuada por la
radiacion electromagnética emitida o reflejada por el objeto irradiador y detectada por
un perceptor, el cual a su vez reconstituye esta energia en una imagen detectable por
nuestros sentidos. Se usan diversos tipos de perceptores remotos, que son aparatos
que miden y registran diversas radiaciones del espectro electro magnético (Lillesand

et al, 2000).

4.2.- Sensores remotos

Alzate (2001) explica que son los dispositivos que permiten la referenciacion
a distancia de la radiacion electromagnética reflejada o emitida por la superficie de la
tierra. Estos son de diferentes tipos, de acuerdo con los principios basicos de disefio,
su forma de registrar los datos y la fuente de energia que emplean. Pueden ser

camaras, radares, barredores Opticos, 6pticos-mecanicos, eléctricos, etc.
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4.3.- Procesos de percepcion remota

Segun Alzate (2001) el proceso involucra una interaccion entre la radiacion
incidente y los objetivos a estudiar, este se ejemplifica en la figura adjunta donde se

siguen siete elementos involucrados. Fig 4.1

' ;
t% A l‘..-"'-'
R Ig

EBCCRS/C

FIGURA N° 4.1 Procesos de percepcion remota, segun CCRS (2007)

A Fuente de energia o iluminacion — el primer requerimiento para sensores remotos
es tener una fuente de energia la cual ilumine o provea de energia electromagnética

los objetivos interés.

B Atmosfera y radiacion — Para que la energia vaya de la fuente hacia el objeto,
necesita atravesar e interactuar con la atmoésfera. Esta interaccion también sucedera

cuando la energia retorne de vuelta desde el objeto al sensor

C Interaccion con el Objeto de interés — cuando la energia llega a la tierra interactaa
con el objeto de interés, conformando por las diversas coberturas de la tierra
(superficie terrestre, atmosfera, océano), esta interaccion se da en forma de algin

fenomeno (reflexion, emision, absorcion)
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D Sistema del sensor — es el que capta, codifica y graba la radiacion que devuelve el
objeto en la tierra, sin estar en contacto con ¢l. Después envia al sistema de recepcion

en tierra, la energia grabada.

E Transmision, recepcion y procesamiento — aqui los datos recibidos en forma digital,

son preprocesados para obtener una imagen, bien sea en papel o en medio digital.

F Interpretacion y analisis — la imagen preprocesada es interpretada en forma visual o

se le aplica adicionalmente procesamiento a través de técnicas digital.

G Aplicacion - es el elemento final del proceso de la percepcion remota. Consiste en
realizar aplicaciones con la informacion temdtica que se extrae de la imagen,
entendiendo el comportamiento de los objetos de interés que fueron censados alli,

para la solucion de algun problema en particular.
4.4.- El espectro electromagnético

El espectro electromagnético es una representacion organizada de la energia
electromagnética, partiendo de longitudes de onda corta, algunos pum, hasta valores

altos (km). En la figura 4.2, se representa las longitudes de onda del espectro

electromagnético (Méndez, 2002)
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FIGURA N° 4.2 El espectro electromagnético Tomado de Méndez (2002)

Las longitudes de onda inferiores a 400nm son ampliamente utilizadas en
medicina, astronomia y microscopia, se destacan los rayos gamma, rayos X y la luz

ultravioleta (Méndez, 2002)

La luz visible, por su parte, corresponde al rango de longitudes de onda a las
cuales es sensible el ojo humano. Las ondas més cortas (400nm) se perciben de color
azul y las mas altas (750nm) se ven de color rojo, las longitudes intermedias se
perciben de color verde (540nm), amarillo (580nm), etc. La luz blanca esta
constituida por una combinacién de ondas con energia semejante y longitudes de
onda en el rango del visible. Este rango de longitudes de onda es el més utilizado para

la generacion de imagenes (Méndez, 2002)

La luz infrarroja cubre el rango del espectro electromagnético con longitudes
de onda que van desde 0,78mm a 1 mm. La banda infrarroja se divide en tres
secciones de acuerdo a su distancia a la luz visible: cercana (780nm a 2.500nm),
intermedia (2.500nm a 50.000nm) y lejana (0,5mm a Imm) esta ltima relacionada

con la temperatura del objeto (Méndez, 2002)

Las microondas (Imm a 30cm) incluyen al radar como fuente de generacioén
de imagenes (Méndez, 2002)
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Las ondas de radio se utilizan en la produccion de imagenes por

ecosonogramas y el sonar en medio marino (Méndez, 2002)

4.5.- Fuentes de energia en la percepcion remota

El sol es la fuente de energia mas comun, que se mide en teledeteccion
terrestre, aun que no es la unica fuente de energia que se puede encontrar. Toda la
materia a temperatura mayor que el cero absoluto (0° Kelvin) continuamente emite

radiacion electromagnética (Alzate, 2001)

Las fuentes de energia se dividen segun el CCRS (2007) en Fuentes Pasivas
Fig. 4.3, que son aquellas fuentes de energia natural, como la energia solar y el calor
radiante; y Fuentes Activas Fig. 4.3.1, que son las fuentes de energia hechas por el
humano, o aquellos sensores que proveen su propia fuente de “iluminacién”. El
sensor emite radiacion sobre el objetivo a investigar y la radiacion reflejada desde el

objetivo es detectada y medida por el sensor, como ejemplo el radar.
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FIGURA N° 4.3 Fuente de energia pasiva Tomado del CCRS (2007)
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© CCRS /CCT
FIGURA N° 4.3.1 Fuente de energia activa Tomado del CCRS (2007)

4.6.- Interaccion de la radiacion electromagnética

La radiacion electromagnética al interactuar con los objetos es modificada de
manera que la energia resultante incorpora informacion que caracteriza al objeto y en
consecuencia indirectamente permite su andlisis. La forma de interaccion de la

radiacion electromagnética y la materia se resume en la figura 4.4 (Méndez, 2002)
De acuerdo a su longitud de onda, una parte de la radiacion incidente en el

objeto es dispersada en diferentes direcciones, otra es absorbida por la materia, otra es

transmitida y otra reflejada.
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absorbida

FIGURA N° 4.4 Interaccion de la radiacion electromagnética con la materia Tomado de Méndez

(2002)

La absorcion ocurre cuando la radiacion (energia) es absorbida dentro del
objeto. La reflexion ocurre cuando la radiaciéon “rebota” del objetivo y es
redireccionado en otra direccion. La transmision, ocurre cuando la radiacion pasa a
través del objetivo, ver figura 4.5. En sensores remotos se esta mas interesado en

medir la radiacion reflejada desde los objetivos (CCRS, 2007)

FIGURA N° 4.5 La energia incidente, A absorcion, R reflexion, T transmision Tomado del CCRS
(2007)
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Existen dos tipos de reflexion, Fig. 4.6: Especular, cuando toda (o la mayoria)
de la energia es desviada desde la superficie en una sola direccion; y Difusa, ocurre
cuando la superficie es rugosa y la energia es reflejada uniformemente en todas las
direcciones. La superficie de la tierra se comporta como un reflector perfectamente

especular o como perfectamente difuso (CCRS, 2007)

FIGURA N° 4.6 Reflexion Especular y Reflexion Difusa, Tomado de CCRS (2007)

4.7.- Reflectancia

Es el cociente de la cantidad de radiacion electromagnética reflejada desde
una superficie sobre la cantidad que originalmente chocé con la superficie, ver Ec. 1.
Esta definicion implica que alguna de la energia que choca en una superficie no es
reflejada, pues puede ser transmitida o absorbida, como ya se menciond (Alzate,
2001)

Ec. 1 Reflectancia = Rs/I

Rs: energia reflejada

I: energia incidente, radiacion reflejada+tradiacion absorbida+radiacion transmitida
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4.8.- Interaccion con la atmosfera

La modificacion atmosférica de la radiacion electromagnética entrante y
saliente incluye dispersion, refraccion y absorcion Fig 4.7. Esos tres procesos
modifican fisicamente la direccion y penetracion de la radiacion electromagnética, en

el momento en que pasa a través de la atmosfera (Alzate, 2001)

4.9.- Dispersion (difusion)

Es el redireccionamiento de la energia electromagnética por particulas
suspendidas en la atmosfera (contaminacion, polvo) o por moléculas grandes de gases
atmosféricos (dioxido de carbono, ozono, nitrogeno). Este redireccionamiento de la

luz puede ser en cualquier direccion (Alzate, 2001)

4.10.- Refraccion

Es la desviacion de la luz. Sucede cuando la luz pasa a través de dos medios

con diferente densidad (capas atmosféricas) (Alzate, 2001)

4.11.- Absorcion

Principalmente causada por tres gases atmosféricos: Ozono, absorbe los rayos
ultravioleta; dioxido de carbono, en la atmodsfera inferior absorbe energia cuya
longitud de onda esta entre los 13 — 17,5 micrometros; vapor de agua, también en la
atmosfera inferior, principalmente en areas humedas es efectivo absorbiendo las
porciones del espectro entre 5,5 y 7 micrometros y por encima de los 27 micrémetros

(Alzate, 2001)
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4.12.- Ventana atmosférica

Son porciones del espectro electromagnético que pueden pasar a través de la
atmoésfera con poca o ninguna atenuacion. La figura 4.8 muestra las areas del
espectro que pueden pasar a través de la atmdsfera sin atenuacion (picos), son

conocidas como “ventanas atmosféricas”, y las areas que son atenuadas (valles)
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FIGURA N° 4.8 Ventanas atmosféricas. Tomado de Alzate (2001)

Las zonas azules sefalan el paso minimo de radiacion entrante o saliente,
mientras que las areas blancas denotan las ‘“‘ventanas atmosféricas” en las cuales la
radiacidon experimenta interacciones muy reducidas con las especies moleculares y

desde aqui puede penetrar la luz, con poca o ninguna pérdida de absorcion (Alzate,
2001)

La mayoria de los sensores remotos fueron seleccionados para operar en una o
mas de esas ventanas y hacen sus mediciones usando detectores calibrados para

ciertas frecuencias especificas (longitudes de onda), que pasan a través de la

atmosfera (Alzate, 2001)
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FIGURA N° 4.7 Interaccion de la energia con la atmosfera y la superficie, tomado y modificado de
ITC (2004)

4.13.- Firmas espectrales
Cada objeto en la superficie terrestre interactua de manera especifica con la

energia electromagnética que sobre el incide ver Fig. 4.9. De acuerdo a las
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caracteristicas del material que lo componen, el objeto refleja con mayor o menor
intensidad cada uno de los rangos de longitudes de onda, esta interaccion particular
de la materia constituye su firma espectral ver Fig. 4.9.1. Por ejemplo, la hoja de los
arboles la percibimos de color verde porque refleja con mayor intensidad las

longitudes de onda visibles de ese color mientras que absorbe el azul y el rojo ver Fig.
4.9.2 (Méndez, 2002)

IR
H

G

FIGURA N° 4.9 Respuesta espectral de la vegetacion, tomado de Méndez (2002)
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FIGURA N° 4.9.1 Firma espectral de la superficie de 5 suelos minerales (a) dominado por material
organico (b) minimamente alterado (c) hierro alterado (d) organico afectado (e) dominado por hierro,

tomado de ITC (2004)
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FIGURA N° 4.9.2 Curva idealizada de reflexion espectral de vegetacion sana, tomado de ITC (2004)
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CAPITULO V
5 METODOLOGIA

Este trabajo se realiz6 siguiendo una combinacién de estrategias tanto de una
investigacion documental, ya que se trata de una compilacion de trabajos previos;
aunados a una investigacion cientifica, debido a que se trabajo segun el método
cientifico procesando datos y obteniendo respuestas medibles de los mismos.

Englobado en el cumplimiento positivo de los objetivos planteados.

A partir de la imagen satelital LandSat 7correspondiente a la Sierra de Perija en el
occidente venezolano en donde se puede apreciar la zona de estudio del presente
trabajo, se realizara el procesamiento correspondiente, con el fin de obtener imagenes

mas puras visualmente para el ojo humano e interpretarlas.

Ademads, durante estd etapa se efectuard el andlisis e interpretacion de la
informacion que se vaya obteniendo dicho procesamiento, y la informacién obtenida
sera integrada y vaciada para asi generar un mapa geologico a escala 1:50.000 de la
zona de estudio. A continuacion se explicara paso por paso el procesamiento de las

imagenes mediante el uso del software ENVI:

5.1.- Correcciones atmosféricas

El primer paso consiste en corregir defectos de éstas imdgenes, elementos
distorsionantes como gases, metano y vapor de agua. Para hacer esta correccion se
debe presionar en el menu principal del software “ENVI” “Basic Tools”->
“Preprocesing”-> “Calibration Utilities”-> “Landsat TM” (ver fig 5.1), luego se
debe seleccionar la banda en una ventana denominada ‘““Please Select a File”, ya
seleccionado el archivo de entrada se procede a hacer clic en “OK”, luego se muestra

en una ventana en la cual se deben introducir los pardmetros de calibracion (ver fig
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5.1) que se encuentran en el archivo “meta” adjunto a las imdgenes Landsat 7. Luego
de introducir estos datos se debe hacer clic en el boton “choose” para determinar el
nombre y el directorio del archivo de salida. Este procedimiento se debe repetir 6

veces mas, con cada uno de los archivos de bandas.

x|

Landsat Satellte © 4 © 5 & ETM+7

Data Acquisiion Morth: |October =

DatacquisiionDay :[4 &
Data Acquisiion Yesr :[2001 2]
Sun Elevation (deg] ;[6058

Calibration Type ¢ Radiance (¢ Reflectance

Scale: Min:|-6.2 Max: |191.6

Get Calibration Parameters from WWeh

Output Resultto & Fils € Memary

Enter Output Filename Choose | | Compress

[
oK Queue | Cancel

FIGURA N°5.1 Menu principal del ENVI y ventana de parametros de calibracion

Las bandas usadas para realizar la correccion atmosférica son del tipo VNIR,
cuyos datos no son manejables, por lo que se requiere minimizar la data existente
para facilitar el manejo de la imagen, entonces se extraen estos datos y solo se dejan

las bandas SWIR. Se debe proceder de la siguiente forma:

En seguida de realizar la calibracion de estos archivos, se deben tomar los
archivos de salida y unirlos haciendo clic en “Basic Tools” -> “Layer Stacking”
(ver figura 5.2). Ahi se despliega una ventana titulada Layer Stacking Parameters,
luego se da un clic en “choose” para determinar la ubicacion y el nombre del archivo
de salida y luego “OK?”, luego se despliega otra ventana titulada Layer Stacking Input
File, en la cual se van a seleccionar como entrada los siete archivos de radiance

corregidos en el paso anterior
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FIGURA N°5.2 Seleccion del Layer Stacking, y ventanas de entrada y de salida de la union de
las bandas

Posteriormente, al archivo de salida resultante del Layer Stacking se le debe
cambiar el formato BSQ a formato BIL, lo cual es necesario para continuar con las
correcciones de la imagen. Para cambiar el formato se debe hacer clic en “Basic
Tools” -> “Convert Data BSQ, BIL, BIP” (ver fig 5.3), se despliega una ventana en
la cual se debe seleccionar el archivo de entrada, el cual es la unién de las bandas
realizada en el paso anterior, luego se hace clic en OK, y después se selecciona el

destino de la salida y el formato BIL (ver figura 5.3)
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FIGURA N°5.3 Seleccion de cambio de formato en el menti de ENVI y seleccion del formato
del archivo de salida.

Finalizado el procedimiento, queda una imagen en formato BIL que significa
bandas intercaladas por lineas, formato que sirve para obtener imagenes corregidas
geométricamente de gran utilidad para la cartografia de la zona, después de la

utilizacion de técnicas de tratamiento digital.

Seguidamente se debe realizar la correccion atmosférica en FLAASH, que
consiste en aplicar un factor de 10 a las bandas debido a que la radiance en imagenes
LANDSAT viene dada en W/m? um sr, y FLAASH requiere las unidades en W/cm?
um sr. Para realizar la correccion FLAASH se debe hacer clic en “Basic Tools” en el
ment principal de ENVI, se selecciona “Preprocesing” -> “Calibration Utilities” -
> “FLAASH” (ver fig 5.4), se despliega una ventana titulada FLAASH atmospheric
correction model input parameters, se hace clic sobre el boton “input radiance
image” que abre la ventana FLAASH input file donde se selecciona el archivo BIL
generado en el paso anterior, luego se presiona “OK”, se despliega otra ventana
llamada input ASCII file y se seleccionan las 6 filas de la columna y se presiona
“OK”. Luego se abre la ventana radiance scale factors en la cual se debe seleccionar
use sigle scale factor for all bands se tipea “10” en single scale factor y se presiona

“OK”. Luego en la ventana titulada FLAASH atmospheric corretion model input
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parameters (ver fig 5.4), se selecciona el archivo de entrada (BIL), luego se colocan
la ubicacién y el nombre del archivo de salida, se suministran los datos provenientes
del archivo “meta” que se encuentra adjunto a las imégenes y luego se hace clic en el
boton “Multiespectral settings” y se despliega la ventana Multiespectral settings
donde se seleccionan las bandas 7 y 3 de la imagen LANDSAT en KT Upper
Channel y en KT Lower Channel respectivamente, se presiona “OK” vy

subsiguientemente muestra la imagen ya corregida.
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FIGURA N°5.4 Correccion FLAASH en el menu principal del ENVI y ventana FLAASH
atmospheric correction model Input parameters
5.2.- Elaboracion de la mascara de nubes
Ahora bien, para continuar con las correcciones, se deben eliminar de la imagen
los pixeles correspondientes a las nubes y su sombra, realizando una mascara en el
software ArcGis con la finalidad de ocultar dichos pixeles para que el software ENVI,

no los confunda con rasgos topograficos.

En primer lugar se abre la seccion Arc Catalog del software ArcGis, se escoge

con el boton derecho del raton la carpeta en donde se guardard el archivo resultante,
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se despliega una ventana en la cual se selecciona Shapefile, seguidamente se abre la
ventana create new shapefile donde se colocan el nombre del shapefile y el tipo de
shapefile que se quiere realizar, luego se hace clic sobre el boton “edit...”, y se
despliega la ventana propiedades de spatial reference, se hace clic sobre el boton
“import...” y se selecciona un archivo que previamente haya sido georeferenciado en
el sistema que se desea, generalmente en este procedimiento se selecciona como
referencia WGS 1984 UTM ZONA 18 N, y finalmente se hace clic en “aceptar” y
“OK”. Se ha creado el shapefile ahora se procede a “calquear” las nubes y sus

sombras en la seccion ArcMap del software ArcGis.

Una vez realizada la mascara en el software ArcGis se debe transformar a un
archivo con extension ROI, esto se hace en el software ENVI, se abre “File”-
> ”Open Vector File” (ver fig 5.5), donde se debe abrir la méscara realizada en
ArcGis, luego se despliega la ventana Import Vector File Parameters (ver figura 5.5),
en la cual se debe seleccionar el archivo de entrada, después se hace clic en
“Choose”, para determinar el nombre y ubicacion del archivo de salida y se clic en
“OK?”. Posteriormente se abre una nueva ventana llamada Available Vector List, en la
cual se escoge el archivo que se import6 anteriormente y se hace clic en “Load
Selected”, se abre una ventana donde se selecciona el archivo al cual se le va a
adjuntar el shapefile y se hace clic en “Apply”, en dicha ventana se abre el menu
“File” -> “Export Active Layer to ROIs”, se despliega una ventana donde se

escoge el método de correccion y se presiona “OK”.
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FIGURA N°5.5 Ment principal de Envi y ventana Import Vector Files Parameters

Seguidamente para colocar la mascara se presiona “Basic tools” en el menu del
software ENVI, se selecciona la opcion “Masking -> “Build mask”, se abre la
ventana Mask Definition, se selecciona “Display # 17, se despliega la ventana
Import ROIs, se hace clic sobre el archivo recién importado y se presiona “OK”, se
regresa a la ventana anterior y se selecciona “choose” donde se le da un nombre al

archivo de salida y se hace clic sobre “Apply”.

5.3.- Transformacion minima de ruido

Luego se hace una transformacion de las variables originales de la imagen para
reducir el tamafo de los archivos y solamente trabajar con los datos importantes de la
imagen, este proceso se denomina Transformacion de la Fraccion Minima del Ruido
(MNF en el software ENVI). Se presiona “Spectral” en el menu principal de ENVI,
luego se selecciona MNF Rotation -> “Forward MNF” -> “Estimate Noise
Statisttics from data”(ver fig 5.6), se abre la ventana MNF Transform Imput File, se

escoge el archivo SWIR creado anteriormente y se hace clic sobre “OK”, se

despliega una ventana llamada Foward MNF Transform Paramaters, se escriben los
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nombres de los archivos de salida en Output Noise Stats Filename y en Enter Output

Filename, y para finalizar se selecciona “OK”.
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FIGURA N° 5.6 Transformacion de la fraccion minima de ruido, menu principal ENVI

5.4.- indice de pureza de pixel (PPI)

Inmediatamente debe realizarse el indice de Pureza del Pixel (PPI). En éste
procedimiento se selecciona los pixeles extremos en la data que satisfacen el nimero
de iteraciones o el factor de tolerancia propuesto por el usuario, lo que aumenta el
nivel de pureza de la imagen. Se hace clic en “Spectral” en el menu principal de
ENVI, se selecciona “Pixel Purity Index” -> “[FAST] New Output Bands”, se
abre la ventana Fast Pixel Purity Index Input Data File (ver fig 5.7), en la cual se
selecciona el archivo MNF creado en el paso anterior. Luego se hace clic en
“Spectral Subset”, se abre la ventana “File Spectral Subset” (ver fig 5.7) donde se
seleccionan las tres primeras bandas (ver fig 5.7), las cuales poseen la mayor
cantidad de informacion util de todas las bandas, se hace clic en “OK” y se regresa a
la ventana anterior, donde se escoge el numero de iteraciones y el factor de tolerancia.

También debe escribir el nombre del archivo de salida y se presiona “OK”.
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FIGURA N°5.7 Ventana Fast pixel Purity Index Inout Data File, y File Spectral Subset. Para el
PPI

Posteriormente se abre la imagen resultante del proceso anterior, una vez abierta
la imagen, se selecciona la opcion “Overlay” del menu principal de ENVI, luego
“Density Slice” (ver fig 5.8), se abre una ventana llamada “Density Slice Bands

Choice” (ver fig 5.8), se selecciona el archivo al que se le aplico PPI y se le hace clic
en “OK”.
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FIGURA N°5.8 Opcion Overlay y Density Slice, y ventana Density Slice Band Choice

Luego se mostrara la ventana #1 Density Slice donde se ven los valores de rango
de la cantidad de pixeles seleccionados, entonces se selecciona “2404 to 2747 [sea
green]” (ver fig 5.9) y se presiona el boton “Apply”, se despliega la ventana #1 PPI
donde se muestran los pixeles extremos. En la ventana #1 MNF Band 1 se selecciona
el menu “Tools” -> “Region Of Interest” -> “Band threshold ROI”, esto se hace
para cambiar la extension del archivo a ROI. Seguidamente se despliega la ventana
“Band Threshold to ROI Input Band” donde se selecciona el archivo PPI y se
presiona “OK”, se despliega la ventana Band Thresh to ROl donde se colocan los
valores maximos y minimos del umbral aceptable en “Min Thresh Value” y “Max
Thresh Value” respectivamente, y se hace clic en “OK”. Los valores minimos y
maximos del umbral deben ser tanteados hasta que en el cuadro emergente ENVI
Question aparezca un numero menor pero aproximado a 10.000 (ver fig 5.9). Luego
de obtener el niimero deseado de puntos, se hace clic en “YES” y el software

comienza a procesar la imagen.
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FIGURA N°5.9 Ventana Density Slice y Ventana ENVI Question donde se observa el nimero
aproximado a 10.000

Consecutivamente se despliega la ventana #1 ROI Tool, en la cual se debe
seleccionar “File” -> “Export ROis to n-D Visualizer...”(ver fig 4.10) y se
presiona “OK”. Después se abre una ventana titulada Select Input Data File donde se
escoge el archivo PPI y se hace clic en “OK”. Después se despliega la ventana n-D
Visualizer input ROIs y se selecciona el umbral de puntos que se obtuvieron en el
paso anterior, luego clic en “OK?”, se despliega otra ventana titulada Output n-DState
donde se debe presionar “Choose” para seleccionar el nombre y ubicacion del
archivo de salida, se presiona “OK”, y el programa regresa a la ventana n-D Controls
(ver fig 5.10), en la cual se debe seleccionar en el menu “File -> Save State...”,
después se debe hacer clic en el menu “Options” -> 3D: Drive Axes, se despliega
una ventana titulada “n-D Controls” y se escoge “1, 2 y 3” (ver fig 5.10), haciendo

clic sobre éstos numeros. Seguidamente se presiona “Start”.
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FIGURA N°5.10 Menu para exportar el ROI al visualizador y ventana n-D Controls

Luego se muestran los pixeles extremos encontrados por la correccion PPI en un
espacio tridimensional (ver fig 5.11), donde se procede a seleccionar manualmente
los pixeles mas extremos observados en dicho espacio, se seleccionan pintando los
pixeles extremos con un color diferente por grupo de pixeles. Al final de este proceso
se obtienen 16 grupos o clases de pixeles extremos, observados en la ventana #1 ROI
Tool, en la misma ventana se seleccionan todas las clases, en la ventana Save ROIs to
File se seleccionan también todas las clases. Luego se debe presionar “Choose” para
determinar el nombre y ubicacion al archivo de salida, y para finalizar se presiona

“OK”.
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FIGURA N°5.11 Espacio Tridimensional donde se seleccionan los pixeles extremos

A las imagenes se les aplico el algoritmo ““Spectral Angle Mapper” (SAM), este
algoritmo calcula la distancia angular existente entre un espectro de referencia y un
pixel cualquiera, esto filtra el nimero de pixeles existentes en la data cuando estos

tengan un angulo mayor al del espectro de referencia.

Entonces, para realizar este algoritmo se selecciona “Spectral” en el menu
principal de ENVI, luego se selecciona “Mapping Methods” -> “Spectral Angle
Mapper” (ver fig 5.12), se abre una ventana titulada Clasification Input File, se
selecciona el archivo obtenido del proceso anterior, se hace clic en el botén “Spectral
Subset”. Seguidamente se despliega la ventana File Spectral Subset en la cual se
escogen las tres primeras bandas y se hace clic en “OK”. Inmediatamente se
despliega la ventana Endmember colletion: SAM, se selecciona el ment “Input” ->
“From ROI/EVF from input file...”, se abre dentro de la misma ventana una tabla
en la que se muestran las clases, se seleccionan todas y se presiona el boton “OK”, se
despliega la ventana “Spectral Angle Mapper Parameters” en la cual se da

ubicacion y nombre al archivo de salida con la correccion SAM.
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FIGURA N°5.12 Ment principal del ENVI para realizar la correccion SAM

5.5.- Clasificacion no supervisada

El siguiente paso es la clasificacion no supervisada, con la cual el programa hace
una clasificacion de los pixeles por caracteristicas similares, que divide el espacio de
las variables en una serie de regiones, de manera que se minimice la varianza interna
de los pixeles incluidas en cada region. Para ello se selecciona “Clasification” en el
menu principal de ENVI, se selecciona la opcion “Unsupervised” -> “IsoData”(ver
figura 5.13), se despliega la ventana Classification Input File donde se escoge el
archivo resultante de la correccion de la imagen en FLAASH, se hace clic en el botén
“Select Mask Band” y se despliega la ventana “Select Mask Input Band” donde se
selecciona el archivo de la mdascara creado anteriormente y se presiona “OK”, se
despliega la ventana ISODATA Parameters, en “Number of classes: Min” se tipea
“15” y en “Max” se tipea “25”. Luego se hace clic en “Choose” para determinar la
ubicacion y el nombre del archivo de salida, y para finalizar se da clic en “OK”. El

programa procesa y muestra los resultados en la ventana #1 Scroll.
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FIGURA N°5.13 Clasificacion no supervisada en el menu principal de ENVI

5.6.- Clasificacion Supervisada

En seguida se debe realizar la clasificacion supervisada, que consiste en hacer una
clasificacion de los pixeles con caracteristicas similares, que el usuario define
mediante la observacion de la imagen. Para hacer esta clasificacion en primer lugar se
debe abrir la imagen resultado de la correccion FLAASH, en el software ERDAS
IMAGINE, en el menu principal de la ventana Viwer #1 se selecciona “Raster” ->
“Tools...” y se despliega la ventana Raster en la cual estdn las herramientas para
modificar las imagenes, se selecciona la herramienta “Create Polygon AOI”, luego
en el menu principal del ERDAS IMAGINE se selecciona “Classifier”, se despliega
la ventana “Classification” y se hace clic sobre el boton “Signature Editor” y se
despliega la ventana “Signature Editor”, posteriormente con la herramienta se hace
un poligono sobre la imagen en aquellas regiones cuyas caracteristicas son similares
tales como: rocas metamorficas sin diferenciar, valles, sembradios, poblados,
carreteras, drenajes, nubes, sombras de nubes y cuerpos de agua; al seleccionar una
clase encerrandola en un poligono se procede a presionar el boton “+ LB (ver
figura 5.14), de inmediato se adhiere la clase seleccionada, se encierran en poligonos
varias clases de las mismas caracteristicas. Luego en la ventana “Signature Editor” se
seleccionan las clases iguales y se presiona el boton “=LP"(ver figura 5.14) para
unir las clases similares en una sola. Este procedimiento se repite tantas veces como
clases se deseen crear. Seguidamente en la ventana Signature Editor se hace clic
sobre “File” -> “Save” y se guardan las clases, en la ventana Viewer #1 se hace clic

en “File” -> “Save” -> “All Layers” y se guarda el archivo de la imagen, luego en
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la ventana classification se hace clic en “Supervised Clasification”, se despliega la
ventana Supervised Clasification y se introducen los nombres del archivo de imagen
recién creado, el nombre del archivo signature y se da un nombre de salida para el
archivo que va a tener la clasificacion supervisada. Para finalizar se hace clic en

“OK” y ya se tiene la clasificacion supervisada.
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FIGURA N°5.14 Apariencia de los botones “+ Ly “= L en ERDAS

5.7.- Cocientes de bandas
Posteriormente se ejecuta el procedimiento de cocientes de bandas. El mismo
consiste en hacer una division entre las bandas de la imagen, con el objetivo de

resaltar caracteristicas especificas de la imagen.

Este procedimiento se cumple en el software ENVI. En el menu principal se
selecciona “Transform” -> “Band Ratios” (ver fig 5.15), se despliega la ventana
“Band ratios Input Bands™ y se introducen las bandas que se van a dividir, en primer
lugar se introduce el numerador y en segundo lugar la banda que ocupara el
denominador, se presiona “Enter Pair” y para finalizar “OK”. Este proceso se
realiza tantas veces como cocientes de bandas se quieran obtener. Existen cocientes

de bandas que han demostrado su efectividad para resaltar ciertos aspectos de la
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cartografia como lo son: 3/1 resalta los 6xidos de hierro, 2/4 6 5/4 resaltan distintos

tipos de vegetacion, 5/7 resalta las arcillas y carbonatos.
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FIGURA N°5.15 Cociente de Bandas en el menu principal de ENVI

5.8.- Realizacion del indice de vegetacion

El siguiente, consiste en identificar la cantidad de material vegetal existente en la
superficie. Para efectuar esto en el software ERDAS se hace clic en “Interpreter”,
se despliega la ventana image interpreter, luego se hace clic sobre el boton “Spectral
Enhancement” lo cual despliega la ventana indice. En ésta ventana se determina el
archivo al cual se le va a aplicar el procedimiento, y se le da una ubicacion y nombre
de salida. Luego en select functions se selecciona “Veg Index”, en sensor se

selecciona Landsat TM. Y para finalizar se presiona “OK” (ver fig 5.16).
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FIGURA N°5.16 Procedimiento en ERDAS para realizar el indice de vegetacion.
5.9.- Firmas Espectrales
A continuacidn se deben realizar las firmas espectrales en ERDAS, que consisten
en caracterizar diferentes lugares de la zona de estudio con la finalidad de obtener su

firma espectral que es caracteristico de cada material que compone la superficie.

Por lo cual, se debe abrir el archivo resultante de la clasificacién supervisada.
Luego en la ventana Viewer #1 se selecciona el menu “Raster ” -> “Tools...”, Se
despliega la ventana Raster (ver fig 5.17), se selecciona la herramienta Create
polygon AOI. Después en el menu principal del ERDAS se hace clic sobre el boton
“Classifier “, se despliega la ventana classification, se hace clic en “Signature
Editor”. Entonces con la herramienta Create poligon se hacen poligonos sobre las
regiones de interés, luego en la ventana signature editor (ver fig 5.17) se presiona el

boton “+ LB, para agregar la clase. Posteriormente se hace clic sobre el botén

““\” y se muestra la ventana signature mean plot (ver fig 5.17) donde se muestra el
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histograma de la clase. Una vez obtenida la firma espectral de la clase, se procede a

determinar el material correspondiente a esa firma espectral.
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FIGURA N°5.17 Firmas espectrales en ERDAS Imagine
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CAPITULO VI
6 RESULTADOS Y ANALISIS

Una vez realizado el procesamiento de las imagenes satelitales, se obtuvieron
numerosas herramientas para la interpretacién de la zona, por lo cual se genera un
mapa geologico utilizando como dato los siguientes elementos: Correccion de imagen
FLAASH, imagenes SAM, imagenes de radar, mapas topograficos, mapas geoldgicos
y firmas espectrales.

Este capitulo consta de tres partes, la primera es el analisis topografico, con la
respectiva discriminacion en unidades morfologicas; la segunda parte es un estudio
litoldgico, basado en la interpretacion de las imagenes satelitales; la tercera parte es
un analisis estructural, que cubre las fallas y pliegues.

6.1.- Analisis Topografico:

La zona de estudio esta conformada por dos unidades importantes, las cuales

son: Unidad de Montafias con valles interdigitados y Unidad de Valle con colinas

(ver fig 6.1).
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FIGURA N°6.1 Croquis tppogréﬁco de la zona de estudio que muestra las dos unidades
topograficas mayores (Mapas TULE -5648- y RIO GUASARE -5748- ambos a Escala 1:100.000)

6.1.1.- Unidad de Montafas con valles interdigitados (ver fig 6.2):

Se encuentra al oeste de la zona de estudio y representa el 60% del area
estudiada. Sus alturas varian desde los 400 m hasta los 2000 m. Las montafas
presentes en esta zona poseen una orientacion preferencial de N45°E. El drenaje en
esta unidad es de tipo dendritico y siempre van por el centro del valle. Hacia el
noroeste de la zona se observan drenajes que por cambios de pendientes desaparecen,
teniendo en esa parte un relieve karstico, donde el agua ha disuelto las calizas
produciendo cuevas por donde se infiltra el agua hacia el subsuelo. Existen dos rios
principales, como lo son rio Guasare y el rio Socuy, los cuales son bastante
rectilineos, lo que indica que estan controlados por la presencia de fallas, fracturas, o

contactos litologicos.
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FIGURA N°6.2 Modelo digital de elevacion de la unidad topografica I (Unidad de montafias
con valles interdigitados)
(Exageracion Vertical 20x, inclinacion 30°)

6.1.2.- Unidad de Valle con colinas (ver fig 6.3):

Se encuentra al este de la zona de estudio, y representa el 40% del area
estudiada. Posee una pendiente muy suave. Dentro de esta unidad se encuentra el
EMBALSE DE TULE, que representa la cuenca hidrografica de la zona. El drenaje
preferencialmente es sinuoso, lo que confirma la baja pendiente de la zona. El drenaje

es escaso, solamente se encuentra el colector principal, como lo es el Rio Cachiri.
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EMBALSES

FIGURA N° 6.3 Modelo digital de elevacion de la unidad topografica II (Unidad de Valle con
colinas)
(Exageracion vertical 20x, inclinacion 15°)

6.2.- Analisis Litologico

Con la ayuda de las imagenes satelitales procesadas, y la recopilacion
bibliografica se establecen los tipos litologicos y edades de las rocas que afloran en la
zona, permitiendo asi realizar descripciones detalladas de cada paquete litologico. En
el area de estudio se encontraron 5 secuencias litologicas de diferente edad:

Precambrico, Paleozoico, Jurasico, Cretacico y Cenozoico.

6.2.1.- Secuencia litolégica del Precambrico:
Est4 representada por la Formacion Perija, la cual estd compuesta por rocas
tales como cuarcitas y esquistos gnesoides intrusionados por granito (ver fig 6.4 y

6.5).
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FIGURA N°6.5 Firmas espectrales de la Formacion Perija.

6.2.2.- Secuencia litolégica del Paleozoico:

Esta representada por el Grupo Rio Cachiri del Devonico, conformado por
lutitas negras, areniscas micaceas, areniscas cuarciferas y calizas (ver fig 6.6 y 6.7);
Formacion Cano Indio del Carbonifero, la cual estd compuesta por areniscas macizas
intercaladas con limolitas (ver fig 6.8 y 6.9); la Formacién Rio Palmar del

Carbonifero-Pérmico que se compone de calizas ooliticas en la base y calizas
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fosiliferas en el resto de la seccion (ver fig 6.10 y 6.11), y rocas intrusivas acidas del

Pérmico (ver fig 6.12'y 6.13)

FIGURA N° 6.6 Imagen satelital e imagen de radar correspondientes al Grupo Rio Cachiri

(Coordenadas en UTM/WGS84)
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FIGURA N° 6.8 Imagen de radar e imagen “Spectral angle mapper” correspondientes a la
Formacién Caio Indio. (Coordenadas en UTM/WGS84)
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FIGURA N°6.9 Firmas espectrales de la Formacion Caio Indio (Coordenadas en

UTM/WGS84)
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FIGURA N°6.10 Imagen de radar e imagen satelital correspondientes a la Formacion Rio

Palmar.
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FIGURA N°6.11 Firmas espectrales de la Formacion Rio Palmar (Coordenadas en
UTM/WGS84)
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FIGURA N°6.12 Imagen “spectral angle mapper” e imagen de radar correspondientes a las
rocas intrusivas acidas del Pérmico. (Coordenadas en UTM/WGS84)

FIGURA N°6.13 Firmas espectrales de las Rocas Intrusivas Acidas del Pérmico.
(Coordenadas en UTM/WGS84)

6.2.3.- Secuencia litolégica del Jurasico:
Esta representada por la Formacion La Quinta, la cual litologicamente esta

compuesta arcosas, tobas y lutitas (ver fig 6.14 y 6.15).
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FIGURA N°6.14 Tmagen “spectral angle mapper” e imagen de radar correspondientes a la
Formacién Macoita. (Coorde_nadas en UTM/WGS84)

1187211

FIGURA N°6.15 Firmas espectrales de la Formacion Macoita. (Coordenadas en
UTM/WGS84)

6.2.4.- Secuencia litolégica del Cretacico:
Esta representada por el Grupo Cogollo el cual se caracteriza por calizas
densas y lutitas oscuras (ver fig 6.16 y 6.17); también se encuentra la Formacion

Mito-Juan que se caracteriza por arcillas (ver fig 6.18 y 6.19)
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&=
FIGURA N°6.16 Imagen “spectral angle mapper” e imagen de radar correspondientes al
Grupo Cogollo. (Coordenadas en UTM/WGS84)

FIGURA N°6.17 Firmas espectrales del Grupo Cogollo. (Coordenadas en UTM/WGS84)
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FIGURA N°6.18 Imagen de radar e imagen “spectral angle mapper” correspondientes a la
Formacion Mito Juan. (Coordenadas en UTM/WGS84)
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FIGURA N°6.19 Firmas espectrales de la Formacion Mito Juan. (Coordenadas en
UTM/WGS84)

6.2.5.- Secuencia litolégica del Cenozoico:

Esta representada por la Formacion Guasare y Marcelina, del Paleoceno, la
primera compuestas por calizas fosiliferas y la segunda por areniscas y lutitas, (ver
fig 6.22 y 6.23); suprayacentemente la Formacion Mirador del Eoceno que contiene
areniscas de grano fino (ver fig 6.20 y 6.21); La Formacion Peroc del Oligoceno con
arcilitas, limolitas, areniscas, anhidritas, lignito, siderita y pirita (ver fig 6.24). Por

ultimo se encuentran los aluviones del Cuaternario Reciente (ver fig 6.25)
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FIGURA N°6.20 Imagen de radar e imagen “spectral angle mapper” correspondientes a la
Formacion Mirador. (Coordenadas en UTM/WGS84)
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FIGURA N°6.21 Firmas espectrales de la Formacion Mirador. (Coordenadas en
UTM/WGS84)
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FIGURA N°6.22 Imagen de radar e imagen “spectral angle mapper” correspondientes a la
Formacion Marcelina. (Coordenadas en UTM/WGS84)
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FIGURA N°6.23 Firmas espectrales de la Formacion Marcelina. (Coordenadas en
UTM/WGS84)

FIGURA N°6.24 Tmagen “spectral angle mapper” y firmas espectrales de la Formacioén
Peroc (Coordenadas en UTM/WGS84)
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FIGURA N°6.25 Imagen “spectral angle mapper” correspondiente Al Cuaternario Reciente
(Coordenadas en UTM/WGS84)

192349

Es de hacer notar que casi siempre en una misma litologia se aprecian valores
distintos para las bandas 4 y 5, esto corresponde al hecho que la banda 4 discrimina
las cantidades biomasa presente en una escena, por lo cual favorece la identificacion
de cultivos-suelo y tierra-agua; mientras que la banda 5 hace una discriminaciéon en
aspectos tales como: tipos de cultivos, cantidad de agua en el suelo y diferencia los
tipos de plantas.

6.3.- Analisis Estructural

El analisis estructural consta de la identificacion y jerarquizacion de
estructuras principales, el respectivo estilo estructural y finalmente el establecer las
fases de deformacion. Las estructuras principales son originadas por las fases de
deformacion. Este analisis se realizo con ayuda de las imagenes de radar en las cuales

se pueden apreciar estas estructuras de manera confiable.
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6.3.1.- Identificacion y jerarquizacion de las estructuras

6.3.1.1.- Fallas Inversas:
Son las estructuras de mayor importancia de la zona de estudio. Estas fallas

son dos y poseen una orientacion preferencial N30E (ver fig 6.23).

802383
1213361

FIGURA N°6.26 Fallas sinestrales marcadas en la imagen de radar correspondiente a la zona de

estudio (Coordenadas en UTM/WGS84)

La falla que se presenta mas hacia el oeste, se encuentra en rocas mesozoicas,
donde las rocas de la Formacion La Quinta (Jurasico) sobrecorren sobre el Grupo
Cogollo (Cretacico). La falla tiene una longitud de 30 km.

La segunda falla que se encuentra entre las dos fallas principales. El
buzamiento de esta falla es casi vertical haciendo que afloren las formaciones Perija
(Precambrico Tardio), Cafio Indio (Carbonifero), y Grupo Rio Cachiri (Devénico) en
contacto con el Grupo Cogollo (Cretacico). La falla tiene una longitud de 42 km.

La tercera falla, es la que se encuentra mas al este de la zona de estudio. Esta

corta a las formaciones Mito Juan (Cretacico), Mirador (Eoceno), Ceibote

92



ACTUALIZACION DE LA GEOLOGIA DE SUPERFICIE DE UN SECTOR DE LA SIERRA DE PERIJA
MEDIANTE LA UTILIZACION DE IMAGENES SATELITALES

(Oligoceno), Peroc (Oligoceno - Mioceno), Macoa, Cuiba. La falla tiene una

longitud de 45 km.

6.3.1.2.- Pliegue Anticlinal Simétrico:

Se encuentra hacia el sur-oeste de la zona de estudio (ver fig 6.27). Su linea de
charnela y plano axial poseen una orientacion N15°E, el plano axial tiene buzamiento
vertical. En su nucleo aflora la Formacion La Quinta (Jurdsico) y en sus flancos el

Grupo Cogollo (Cretacico).

802383
[1213361]

FIGURA N°6.27 Imagen de radar donde se puede apreciar el anticlinal simétrico
(Coordenadas en UTM/WGS84)

6.3.1.3.- Pliegues Sinclinales Simétricos:

En la zona de estudio existen dos sinclinales simétricos (ver fig 6.28): El
primero se encuentra 10 km al este del anticlinal mencionado anteriormente. El plano
axial de este anticlinal tiene buzamiento vertical, y el rumbo tanto del plano axial
como de la linea de charnela es N30°E, y en su nucleo se encuentra la Formacion
Mito Juan y hacia sus flancos El Grupo Cogollo. El segundo sinclinal es de geometria
curvilinea, es decir, hacia el sur el rumbo de su eje es N20°E y hacia el norte es N-S.

En este segundo sinclinal intervienen las Formacion la Quinta y EI Grupo Cogollo.
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FIGURA N° 6.28 Imagen de radar donde se pueden apreciar los sinclinales
(Coordenadas en UTM/WGS84)

6.3.2.- Estilo Estructural:

A la zona de estudio se le atribuye un estilo estructural eyectivo, debido a que
la deformacion ductil de la zona estd representada por sinclinales amplios
intercalados con anticlinales mas estrechos. Estos Anticlinales que no eran simétricos
sino en forma de rodilla han desaparecido debido a que su linea de cresta fue
erosionada y el sistema aprovechod esa zona de debilidad para originar un corrimiento
(ver fig 6.29). Solo se puede apreciar un anticlinal simétrico que es el que se
encuentra al sur-oeste. Ademads se determind que existe un estilo zocalo debido a que

también existe deformacion en el basamento.
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FIGURA N°6.29 Desaparicion del anticlinal y formacién de un corrimiento
6.3.3.- Fases de deformacion:
Se determinaron tres fases de deformacion presentes en la zona: La primera

fase es de distension en el rift del Jurasico donde se producen fallas normales de alto

buzamiento en el basamento. (ver fig 6.29)
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FIGURA N° 6.30 Distension en el ““rift”” del Jurasico que produce fallas normales

La segunda fase es el establecimiento del margen pasivo en el Cretacico
Temprano, periodo en el cual se depositaron espesas secuencias lutitas y calizas. La
tercera fase de deformacion es de levantamiento en el Eoceno donde la zona de

estudio es afectada por esfuerzos compresivos (ver fig 6.30) con rumbo N60°W que
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da como resultado el plegamiento y fallas inversas de buzamiento vertical por los

mismos planos de falla en los cuales se produjeron las fallas normales del rift Jurésico.
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FIGURA N°6.31 Compresion del Eoceno que genera fallas inversas de alto angulo por
Los mismos planos de falla que ocurrieron las fallas normales (inversion tectonica)
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CAPITULO VII
CONCLUSIONES, SUMARIO Y RECOMENDACIONES

SUMARIO Y CONCLUSIONES

» Se logro realizar un mapa geoldgico actualizado a escala 1:100.000 mediante
la integracion geoldgica de la informacion recopilada de datos bibliograficos
y trabajos previos con los resultados del andlisis de imdagenes satelitales
(Landsat 7 ETM), donde quede evidenciada la correspondencia entre la
geologia superficial obtenida de los estudios previos y la informacion

obtenida de las imagenes multiespectrales.

» Con el analisis de las imagenes multiespectrales se pudo determinar con
precision las diferentes unidades litoestratigraficas presentes en la zona de

estudio, estableciendo la presencia de contactos entre grupos de rocas distintas

» La correspondencia entre las imagenes procesadas y el mapa geoldgico
demuestra que la herramienta es confiable para la realizacion de un

cartografiado geoldgico.

» La presencia de nubes en la imagen impide tener una vision completa de la
zona por lo cual es necesario recurrir a otra fuentes de informacion, tales

como mapas geologicos previos e imagenes de radar.

» Las imagenes satelitales junto a las otras herramientas facilitan la
discriminacion de rasgos importantes. Entre estas herramientas tenemos el
modelo digital de elevacion, que permite tener una vision global de la zona en
tres dimensiones, para asi poder visualizar los rasgos distintivos de cada

unidad topografica.
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El procesamiento de correcciones atmosféricas realizado permite Ia
adecuacion de las imagenes a su interpretacion, ya que elimina “ruidos” o

distorsiones producto de los gases atmosféricos.

La clasificacién no supervisada realz6 rasgos geologicos que sirvieron para

definir contactos entre las unidades presentes en la zona de estudio.

El estudio geomorfologico dejo dos unidades claramente diferenciables como
lo son unidad de montafas simétricas con valles interdigitados al oeste y la
unidad de valles con colinas al este, presentandose la zona en forma de

escalon

Las fallas inversas muestran dos tendencias, la primera de sobrecorrimientos
debidos a los esfuerzos tectonicos del Cretacico superior — Cenozoico, y la
segunda es un tendencia de inversion de fallas normales jurasicas, creando

fallas inversas de alto angulo que exponen rocas precambricas.

Los plegamientos son de edad post Cretacico y corresponden a los mismos

esfuerzos que elevaron la sierra en el Cenozoico.

Los sinclinales se caracterizan por no presentar antiformes debido a que son
controlados por fallas que expusieron los antiformes a agentes erosivos. Como
evidencia quedan las fallas subparalelas a los sinclinales y el antiforme no

asociado a falla del oeste de la region.

Se concluye que la region presenta un estilo estructural eyectivo y de zocalo.
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» Se determinan tres fases de formacion geologica, la primera de Rift Jurasico,
la segunda de margen pasivo en el Cretacico, y la tercera fase de compresion

de margen activo, para el Eoceno.

RECOMENDACIONES
» Para hacer un estudio basado en imagenes LANDSAT, se debe disponer de

otras herramientas tales como mapas topograficos, imagenes de radar, mapas
geoldgicos previos, en las cuales apoyar la informacion del las imagenes
LANDSAT, incluyendo salidas de campo, en la manera de lo posible, que

corrobore la informacion.

» Se puede recurrir a centros de informacion como la coleccion Creole, que
cuenta con mas de 150mil de secciones finas, para obtener datos de la

litologia de zonas inaccesibles como la Sierra de Perija.

» Las imagenes LANDSAT son Optimas para la realizacion de estudios
regionales, mientras que no se recomiendan para hacer estudios locales,

debido a que la resolucion es baja, de unos 30m por pixel.

» El estudio de las imagenes multiespectrales muestran con claridad las
litologias diferentes mediante el uso de firmas espectrales, por lo que se
recomiendan para estudios geoldgicos, mientras las radargrafias muestran con
claridad las estructuras geoldgicas como fallas, sinclinales y anticlinales, por

lo que se recomienda su uso para estudios estructurales.

» Los software utilizados ENVI, ArcGis y ERDAS, requieren de computadores
de alto desempeio, por lo que se recomienda utilizar el equipo mas potente
posible para evitar inconvenientes que impidan el cumplimiento de los
cronogramas de trabajo. Por otra parte se recomienda migrar a software libre,
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que no involucre el pago de licencias ni los inconvenientes que dichas

licencias generan para el uso masivo de estas herramientas.

» Se recomienda el uso de otras imagenes satelitales como la ASTER e
HYPERION, que con una mayor cantidad de bandas y una mejor resolucion

puede detallar mas aspectos tanto litologicos como estructurales.

» Se recomienda uso de imagenes de Radar, Quizbird, Spot y fotos aéreas, para

estudios estructurales, ya que poseen una magnifica resolucion espacial.

» Las imagenes procesadas en este trabajo estan lo suficientemente avanzadas

en tratamiento digital como para utilizarse en exploracion de hidrocarburos.
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